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Wstęp

Oracle Open Office 3.3 jest w pełni funkcjonalnym pakietem do zastosowań biurowych. W
pakiecie pliki są zapisywane w standardowym formacie OpenDocument (ODF). Pakiet
umożliwia również otwieranie, edytowanie i zapisywanie plików w wielu innych formatach np.
Microsoft Office.

Uwagi dla użytkowników podręcznika
Niniejszy podręcznik stanowi podstawowe źródło informacji dla osób, które chcą zainstalować
pakiet Oracle Open Office 3 i natychmiast zacząć go używać. Jeżeli podręcznik nie zawiera
odpowiedzi na jakieś pytanie, należy skorzystać z opcji pomocy dostępnej w każdym programie
pakietu Oracle Open Office 3.

Zawartość podręcznika
Rozdział 1 zawiera przegląd pakietu Oracle Open Office 3.

Rozdział 2 zawiera informacje o instalacji pakietu we wszystkich obsługiwanych systemach
operacyjnych.

W rozdziale 3 opisano sposób uruchamiania programów pakietu Oracle Open Office 3 i
interpretacji informacji wyświetlanych na ekranie.

W kolejnych rozdziałach opisano główne programy i moduły pakietu.

Dodatek zawiera listę najczęściej stosowanych skrótów klawiszowych.

Słownik zawiera definicje zwrotów używanych w podręczniku.

Uwaga – Ze względu na różnice pomiędzy systemami operacyjnymi ilustracje przedstawione w
tym dokumencie mogą różnić się od danych wyświetlonych na komputerze.
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Informacje dodatkowe
Książki z kolekcji Oracle Open Office 3 można wyświetlić i pobrać pod adresem
http://docs.sun.com/app/docs/coll/2582.1.

Oracle Open Office i OpenOffice.org to dwa pakiety oprogramowania biurowego z tą samą bazą
kodu. Odpowiedzi na wiele pytań dotyczących pakietu Oracle Open Office można znaleźć na
stronach z dokumentacją pakietu OpenOffice.org. Na stronie internetowej dokumentacji
pakietu OpenOffice.org dostępnej pod adresem http://documentation.openoffice.org

znajdują się łącza do dokumentacji, podręczników, kursów, forów użytkowników itp. Zestaw
dokumentacji jest dostępny pod adresem http://wiki.services.openoffice.org/wiki/

Documentation.

Łącza do innych stron powiązanych tematycznie
W tym dokumencie znajdują się również adresy URL do innych stron internetowych
zawierających dodatkowe, powiązane tematycznie informacje.

Uwaga – Firma Oracle nie ponosi odpowiedzialności za dostępność innych stron internetowych
wymienionych w tym dokumencie. Firma Oracle nie uznaje ani nie ponosi odpowiedzialności
za zawartość, reklamy, produkty lub inne materiały dostępne na tych stronach internetowych
lub zasobach albo za ich pośrednictwem. Firma Oracle nie ponosi odpowiedzialności za
faktyczne lub domniemane uszkodzenia lub straty powstałe faktycznie lub w sposób
domniemany wskutek zastosowania lub w powiązaniu z zawartością, dobrami albo usługami
dostępnymi na tych stronach internetowych lub zasobach albo za ich pośrednictwem.

Dokumentacja, pomoc techniczna i szkolenie
Dodatkowe zasoby można znaleźć w następujących witrynach internetowych:

■ Dokumentacja (http://docs.sun.com)
■ Pomoc techniczna (http://www.oracle.com/us/support/systems/index.html)
■ Szkolenia (http://education.oracle.com).

Wstęp
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Firma Oracle zachęca użytkowników do wyrażenia opinii
Firma Oracle zachęca użytkowników do wyrażenia opinii i przesłania sugestii na temat jakości i
użyteczności dokumentacji. Jeśli użytkownik chciałby zgłosić usterkę lub przesłać sugestię
ulepszenia produktu, może to zrobić na stronie http://docs.sun.com po kliknięciu łącza
Feedback (Opinia). Należy wskazać tytuł i numer części dokumentu oraz, jeśli jest to możliwe,
rozdział, sekcję i numer strony.

Oracle Technology Network (http://www.oracle.com/technetwork/index.html) to baza, w
której można znaleźć zasoby dotyczące oprogramowania firmy Oracle:

■ Problemy techniczne i ich rozwiązania można omówić na forach dyskusyjnych
(http://forums.oracle.com).

■ Szczegółowe samouczki znajdują się na stronie Oracle By Example (http://
www.oracle.com/technetwork/tutorials/index.html).

■ Przykład kodu można pobrać ze strony Sample Code (http://www.oracle.com/
technology/sample_code/index.html).

Wstęp
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Informacje o pakiecie Oracle Open Office 3

Pakiet Oracle Open Office 3 to pełny pakiet biurowy. Jego pierwsza wersja, StarOffice 3.0,
została wydana w 1995 roku, podczas gdy moduły w rodzaju StarWriter lub StarCalc były
dystrybuowane już w połowie lat osiemdziesiątych. Bieżąca wersja pakietu została opracowana
na podstawie pakietu OpenOffice.org i obsługuje ten sam format plików — OpenDocument.

Pakiet Oracle Open Office 3 zawiera następujące aplikacje:

■ Program Writer umożliwia projektowanie oraz tworzenie dokumentów tekstowych
zawierających grafikę, tabele i wykresy. Dokumenty można następnie zapisywać w
różnorodnych formatach, w tym w standardowym formacie OpenDocument (ODF),
formacie Microsoft Word .doc lub HTML. Możliwe jest również eksportowanie
dokumentów w łatwy sposób do formatu PDF.

■ Program Calc to aplikacja typu arkusz kalkulacyjny służąca do obliczeń, analiz i zarządzania
danymi. Umożliwia także importowanie i modyfikowanie arkuszy kalkulacyjnych
programu Microsoft Excel.

■ Program Impress pozwala na tworzenie profesjonalnych pokazów slajdów mogących
zawierać wykresy, rysunki, tekst, multimedia i różne inne elementy. Umożliwia także
importowanie i modyfikowanie prezentacji programu Microsoft PowerPoint.

■ Program Draw pozwala na tworzenie prostych czy złożonych rysunków oraz eksportowanie
ich do wielu powszechnie stosowanych formatów plików graficznych. Za jego pomocą do
rysunków można również wstawiać tabele, wykresy, wzory i inne elementy utworzone w
programach pakietu Oracle Open Office.

■ Baza danych Base to interfejs obsługujący szeroki zakres formatów plików baz danych.
Program Base bezpośrednio obsługuje formaty bazy danych HSQL i niektóre formaty baz
danych w zwykłych plikach tekstowych, takie jak format dBASE. Programu Oracle Open
Office Base można również użyć do połączenia z zewnętrznymi relacyjnymi bazami danych,
takimi jak bazy MySQL lub Oracle.

■ Program Math dostarcza szeregu operatorów, funkcji i pomocy formatowania w celu
łatwiejszego tworzenia wzorów na ekranie i do wydruku.

R O Z D Z I A Ł 1
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Podstawowe informacje o oprogramowaniu Oracle Open
Office

Oprogramowanie jest dostępne dla wielu systemów operacyjnych, na różnych platformach i w
wielu wersjach językowych. Dokumenty są zapisywane w formacie OpenDocument (ODF)
zachowującym standard ISO. Podczas korzystania z pakietu Oracle Open Office pliki z
rozszerzeniem ODF mogą być udostępniane pomiędzy systemami operacyjnymi bez
konieczności ich konwersji. Aby uzyskać więcej informacji o formacie OpenDocument, patrz
http://en.wikipedia.org/wiki/OpenDocument.

Informacje na temat głównych funkcji pakietu Oracle Open Office 3 można znaleźć w witrynie
internetowej produktu pod adresem www.oracle.com/office.

Istnieje wiele rozszerzeń do programów Oracle Open Office i OpenOffice.org, dostarczających
dodatkowych funkcji, np. funkcje sprawdzania pisowni, szablony, funkcje kalkulatora itp.
Rozszerzenia tego typu można pobrać ze stronyhttp://
extensions.services.openoffice.org.

Podstawowe informacje o oprogramowaniu Oracle Open Office
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Instalowanie pakietu Oracle Open Office 3

W tym rozdziale opisano procedurę instalacji i usuwania pakietu Oracle Open Office 3 na
platformach Windows, Mac OS X, Solaris i Linux.

Uwaga – Przed rozpoczęciem instalacji pakietu należy przeczytać plik Readme znajdujący się w
katalogu z plikami instalacyjnymi. Plik Readme może zawierać ważne i najnowsze informacje,
których nie znajdzie się w tym podręczniku.

Podręcznik administratora znajdujący się w kolekcji http://docs.sun.com/app/docs/coll/
2582.1 zawiera informacje o narzędziach, których można użyć do obsługi pakietu w sieci.

Uwaga – Oprogramowanie jest dostępne w postaci pliku z systemu E-Delivery w formacie ZIP.
W momencie pobierania i rozpakowywania pliku ZIP na dysku twardym jest niezbędne wolne
miejsce o wielkości przekraczającej dwukrotnie rozmiar pliku. Podczas instalacji
oprogramowania potrzebne jest więcej miejsca na foldery docelowe i zapisywanie plików
tymczasowych.

Instalowanie pakietu Oracle Open Office 3 w systemie
Windows

Poniższe rozdziały opisują procedurę instalacji, modyfikacji i usuwania pakietu Oracle Open
Office 3 w systemie operacyjnym Microsoft Windows.

Wymagania systemowe dla instalacji w systemie
Windows
■ Microsoft Windows 2000 (Service Pack 4 lub nowszy), XP, Vista lub Windows 7

R O Z D Z I A Ł 2
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■ Komputer PC z procesorem zgodnym z Pentium (zalecany procesor Pentium III lub
Athlon)

■ 256 MB pamięci RAM (zalecane 512 MB)
■ Do 1,5 GB wolnego miejsca na dysku twardym
■ Rozdzielczość 1024 x 768 (zalecana wyższa), co najmniej 256 kolorów

Instalowanie w systemie Windows
Po pobraniu pakietu instalacyjnego Oracle Open Office z systemu E-Delivery rozpakuj go w
katalogu.

Uwaga – W razie potrzeby instalator pakietu Oracle Open Office 3 spowoduje usunięcie
poprzednich wersji oprogramowania.

▼ Procedura instalacji w systemie Windows
Do zainstalowania pakietu Oracle Open Office 3 wymagane jest posiadanie uprawnień
administratora.

Znajdź katalog z plikami instalacyjnymi pakietu Oracle Open Office 3.

Kliknij dwukrotnie aplikację Setup.

Aby zmienić folder instalacyjny lub listę instalowanych programów, wybierz ustawienia
niestandardowe.

Zaznacz, czy chcesz ustawić dostępność dla wielu użytkowników, czy tylko dla jednego.

W przypadku wyboru dostępności dla wielu użytkowników ikony uruchomienia programów
pakietu Oracle Open Office 3 zostaną przekopiowane do menu Start każdego użytkownika.

Zakończ pozostałą część instalacji.

Polecenia i ikony do uruchomienia programów Writer, Calc, Impress, Draw oraz Base zostały
dodane do listy programów w menu Start systemu Windows. Dodatkowa ikona pakietu Oracle
Open Office 3 umieszczona na pulpicie pozwala uruchomić oprogramowanie i wyświetlić
centrum startowe.

Przed
rozpoczęciem

1
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5

Instalowanie pakietu Oracle Open Office 3 w systemie Windows
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▼ Procedura zmiany lub usunięcia pakietu Oracle Open
Office w systemie Windows

Uwaga – Poniżej opisano procedurę dostępu do okna dialogowego instalatora pakietu Oracle
Open Office w systemie Windows 7. Ta procedura może różnić się w przypadku innych
systemów Windows.

Zamknij wszystkie programy pakietu Oracle Open Office, w tym narzędzie szybkiego
uruchamiania (Quickstarter) umieszczone na pasku zadań systemu Windows.

Wybierz menu Start systemu Windows→Panel sterowania, a następnie kliknij dwukrotnie ikonę
Dodaj lub usuń programy.

Z listy programów wybierz pozycję Oracle Open Office 3.

Zmień lub usuń zainstalowane oprogramowanie Oracle Open Office 3.

■ Aby zmienić listę zainstalowanych komponentów oprogramowania Oracle Open Office 3,
kliknij polecenie Zmień.

■ Aby usunąć cały pakiet Oracle Open Office 3, kliknij polecenie Usuń.

Uwaga – Ustawienia i dokumenty nie zostaną usunięte.

Instalowanie w systemie Mac OS X
W tej części opisano procedurę instalacji i usuwania pakietu Oracle Open Office 3 w systemie
Mac OS X.

Wymagania systemowe dla instalacji w systemie Mac
OS X
■ System Mac OS X 10.4 (Tiger) lub nowszy
■ Procesor Intel
■ 512 MB pamięci RAM
■ Do 1,5 GB wolnego miejsca na dysku twardym
■ Karta graficzna o rozdzielczości 1024 x 768 i 256 kolorach (zalecana wyższa rozdzielczość)

Przed
rozpoczęciem

1

2

3

Instalowanie w systemie Mac OS X
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Wersje pakietu Oracle Open Office 3 przeznaczone dla systemów UNIX nie mogą być
instalowane w partycjach (V)FAT, ponieważ systemy plików FAT nie obsługują tworzenia łączy
symbolicznych. Ścieżka do katalogu instalacyjnego Oracle Open Office 3 nie może zawierać
spacji.

Instalowanie lub usuwanie oprogramowania
W celu zainstalowania pakietu Oracle Open Office 3 znajdź plik .dmg w folderze Oracle
E-Delivery. Przeciągnij i upuść ikonę pakietu Oracle Open Office na ikonę Application.

Aby usunąć pakiet Oracle Open Office 3, przeciągnij ikonę pakietu na ikonę Trash.

Instalowanie rozszerzeń w systemie Mac OS X
W systemie Mac OS X nie ma programu instalacyjnego. Zatem nie można wykonać instalacji
zdefiniowanej przez użytkownika. Zamiast tego należy przeprowadzić instalację w sposób
opisany powyżej, a następnie dodać wymagane pliki rozszerzeń. Aby zainstalować rozszerzenia
Oracle Weblog Publisher, Oracle Wiki Publisher i eFax Messenger, wybierz pozycje
Narzędzia→Menedżer rozszerzeń i dodaj rozszerzenia z folderu rozszerzeń w zestawie plików
systemu Oracle E-Delivery.

Instalacja w systemie operacyjnym Linux lub Solaris
W tej części opisano procedurę instalacji i usuwania pakietu Oracle Open Office 3 na
komputerach z zainstalowanym systemem operacyjnym Linux, Solaris SPARC lub Solaris x86.

Wymagania dla instalacji w systemie Linux
■ Jądro Linux w wersji 2.6.18 lub nowszej
■ Pakiet glibc2 w wersji 2.5 lub nowszej
■ Biblioteka gtk w wersji 2.10.4 lub nowszej
■ Komputer PC z procesorem zgodnym z Pentium (zalecany procesor Pentium III lub

Athlon)
■ 256 MB pamięci RAM (zalecane 512 MB)
■ Do 1,55 GB wolnego miejsca na dysku twardym
■ Serwer X z rozdzielczością 1024 x 768 (zalecana wyższa) i co najmniej 256 kolorami
■ Menedżer okien
■ Środowisko Gnome 2.16 lub nowsze, z pakietami gail 1.8.6 i at-spi 1.7, wymagane do

korzystania z narzędzi technologii ułatwień dostępu (narzędzia AT)

Instalacja w systemie operacyjnym Linux lub Solaris
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Jeśli używana dystrybucja systemu Linux to Debian, do instalacji pakietu Oracle Open Office 3
należy użyć polecenia “alien”:

Wpisz następujące polecenie: sudo alien -I -k {path/to/rpm/packages} /*.i586.rpm

{path/to/rpm/packages} to katalog, w którym znajdują się pakiety RPM do produktu Oracle
Open Office 3. Uwaga: Ukończenie tego procesu może potrwać kilka minut.

Wersje pakietu Oracle Open Office 3 przeznaczone dla systemów UNIX nie mogą być
instalowane w partycjach (V)FAT, ponieważ systemy plików FAT nie obsługują tworzenia łączy
symbolicznych. Ścieżka do katalogu instalacyjnego Oracle Open Office 3 nie może zawierać
spacji.

Uwaga – W systemie Linux pakiet Oracle Open Office 3 można zainstalować tylko dla jednego
użytkownika. Ta procedura instalacji nie wymaga uprawnień administratora, jednak po
zakończeniu instalacji nie zostanie przeprowadzona kompletna integracja oprogramowania z
systemem. W trakcie instalacji dla jednego użytkownika wszystkie pliki zostaną przekopiowane
do folderu głównego. W celu zainstalowania pakietu na własne potrzeby można uruchomić
program instalacyjny jako zwykły użytkownik.

Wymagania dla instalacji w systemie Solaris
■ System operacyjny Solaris 10 (platforma SPARC lub x86) lub nowszy
■ 256 MB pamięci RAM (zalecane 512 MB)
■ Do 1,55 GB wolnego miejsca na dysku twardym
■ Serwer X z rozdzielczością 1024 x 768 (zalecana wyższa) i co najmniej 256 kolorami
■ Menedżer okien
■ Środowisko Gnome 2.6 lub nowsze, z pakietami gail 1.8.6 i at-spi 1.7, wymagane do

korzystania z narzędzi technologii ułatwień dostępu (narzędzia AT)

Wersje pakietu Oracle Open Office 3 przeznaczone dla systemów UNIX nie mogą być
instalowane w partycjach (V)FAT, ponieważ systemy plików FAT nie obsługują tworzenia łączy
symbolicznych. Ścieżka do katalogu instalacyjnego Oracle Open Office 3 nie może zawierać
spacji.

▼ Procedura instalacji na platformie Linux lub Solaris
Otwórz powłokę okna terminalu.

Wpisz su -, aby uzyskać status superużytkownika.

1

2

Instalacja w systemie operacyjnym Linux lub Solaris
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Korzystając ze statusu swojego konta, uzyskaj uprawnienia do otworzenia interfejsu
graficznego administratora.
XAUTHORITY=/home/username/.Xauthority; export XAUTHORITY

DISPLAY=:0.0; export DISPLAY

Przejdź do katalogu z programem instalacyjnym pakietu Oracle Open Office 3

Uruchom skrypt instalacyjny.
./setup

Postępuj zgodnie z instrukcjami.

▼ Procedura usuwania pakietu na platformie Linux lub
Solaris

Otwórz powłokę okna terminalu.

Wpisz su -, aby uzyskać status superużytkownika.

Korzystając ze statusu swojego konta, uzyskaj uprawnienia do otworzenia interfejsu
graficznego administratora.
XAUTHORITY=/home/username/.Xauthority; export XAUTHORITY

DISPLAY=:0.0; export DISPLAY

Przejdź do katalogu z programem instalacyjnym pakietu Oracle Open Office 3

Uruchom skrypt instalacyjny.
./setup

Wybierz oprogramowanie do odinstalowania.

Postępuj zgodnie z instrukcjami.

3
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Rozszerzenia instalacyjne
Rozszerzenia to pliki z dodatkowymi funkcjami instalowanymi w pakiecie Oracle Open Office.
Pliki kolejnych rozszerzeń można pobrać z odpowiedniej witryny internetowej (patrz poniżej).

Niektóre rozszerzenia są już zainstalowane. Zintegrowane moduły oprogramowania są
wymienione w sekcji definiowanej przez użytkownika oprogramowania instalatora (Setup.exe
dla systemu Windows lub skryptu instalacyjnego w systemie Linux bądź Solaris). Rozszerzenia
można instalować lub usuwać w menedżerze rozszerzeń dostępnym z menu Narzędzia.

Udostępniane rozszerzenia są instalowane dla wszystkich użytkowników. W menedżerze
rozszerzeń są oznaczone symbolem blokady. Użytkownik może instalować rozszerzenia będące
składnikami pliku systemu E-Delivery lub pobrane z witryny internetowej rozszerzeń
(http://extensions.services.openoffice.org).

Aby zainstalować rozszerzenie za pomocą menedżera plików, kliknij dwukrotnie plik
rozszerzenia.

Aby zainstalować rozszerzenie z menu pakietu Oracle Open Office, wybierz pozycje
Narzędzia→Menedżer rozszerzeń, a następnie kliknij przycisk Dodaj.

Podczas instalacji z uprawnieniami administratora należy podać, czy instalacja ma być
przeprowadzona na własne potrzeby czy dla wszystkich użytkowników.

Po instalacji rozszerzenia zaleca się ponowne uruchomienie pakietu Oracle Open Office.

Rozszerzenia instalacyjne
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Zapoznanie się z pakietem Oracle Open Office

W tym rozdziale opisano procedurę uruchamiania programów pakietu Oracle Open Office 3
oraz pracy z elementami wspólnymi dla wszystkich aplikacji.

Uruchamianie programów pakietu Oracle Open Office 3
Sposób uruchomienia programów pakietu Oracle Open Office 3 zależy od rodzaju używanego
systemu operacyjnego.
■ Aby uruchomić programy pakietu Oracle Open Office w systemie Windows, kliknij

dwukrotnie ikonę aplikacji na pulpicie. Ewentualnie otwórz menu Start, a następnie grupę
programów Oracle Open Office i wybierz program, który chcesz uruchomić.

■ Aby uruchomić programy pakietu Oracle Open Office w systemie Linux lub Solaris,
wykonaj następujące czynności:
■ Otwórz okno terminalu i wpisz soffice.
■ Wybierz pakiet Oracle Open Office 3 z menu aplikacji.
■ Kliknij dwukrotnie ikonę Oracle Open Office 3 na pulpicie, jeżeli jest dostępna.

■ Aby uruchomić programy pakietu Oracle Open Office w systemie Mac OS X, kliknij ikonę
Oracle Open Office w folderze aplikacji.

Kreator powitalny i Centrum startowe.
W momencie pierwszego uruchomienia pakietu Oracle Open Office 3 kreator powitalny
wyświetli serię okien dialogowych. Zostanie wyświetlona prośba o przeczytanie i
zaakceptowanie umowy licencyjnej. Następnie należy podać nazwę użytkownika i zadecydować
o przeprowadzeniu rejestracji oprogramowania.

Rejestracja oprogramowania wprawdzie jest zalecana, ale nie wymagana. Menu Pomoc
umożliwia późniejszą rejestrację produktu. Po wybraniu opcji rejestracji w przeglądarce
internetowej zostanie wyświetlona strona rejestracji.

R O Z D Z I A Ł 3
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Następnie po zakończeniu pracy w kreatorze powitalnym zostanie wyświetlone okno centrum
startowego pakietu Oracle Open Office 3.

Kliknij ikonę, aby uruchomić odpowiedni program pakietu Oracle Open Office 3. Przykładowo
kliknięcie ikony Dokument tekstowy spowoduje otworzenie nowego dokumentu programu
Writer.

Kliknij ikonę Otwórz, aby wybrać dokument do otwarcia. Za pomocą strzałki w dół obok ikony
Otwórz wyświetlana jest lista ostatnio otwartych plików. Ikona Szablony umożliwia otwarcie
okna Szablony i dokumenty. Patrz rozdział “Korzystanie z szablonów” na stronie 28.

Po zamknięciu wszystkich dokumentów nastąpi powrót do Centrum startowego.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
Do wykonywania zadań w programach pakietu Oracle Open Office 3 można posługiwać się
poleceniami menu, paskami narzędzi, skrótami klawiszowymi lub kombinacją wszystkich tych
trzech metod. Ikony w pasku narzędzi lub skróty klawiszowe umożliwiają przyspieszenie
najczęściej wykonywanych zadań, np. kopiowanie i wklejanie tekstu do dokumentu.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
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Wspólne menu
Pasek menu znajdujący się w górnej części okna pakietu Oracle Open Office 3 zawiera
polecenia, które można wydać dla zaznaczonych elementów. Wybierz nazwę menu, a następnie
wybierz polecenie. Niedostępne polecenia są wyszarzone.

Porada – Polecenie można również wybrać, korzystając z odpowiedniej kombinacji klawiszy.
Aby na przykład otworzyć dokument, naciśnij klawisze Control+O, tzn. przytrzymaj klawisz
Control i naciśnij klawisz O. Klawisze skrótów są wyświetlane obok poleceń w menu. W
systemie Mac OS X, należy posłużyć się klawiszem Command zamiast Control.

Inną metodą uzyskania dostępu do poleceń pakietu Oracle Open Office jest użycie menu
kontekstowego. Menu kontekstowe jest otwierane po kliknięciu prawym przyciskiem myszy
wewnątrz dokumentu.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
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Uwaga – W przypadku korzystania z klawiatury Macintosh należy posłużyć się klawiszami
analogicznymi do podanych w tym podręczniku. Aby otworzyć menu kontekstowe, naciśnij
klawisze Shift+F10.

Wspólne paski narzędzi
Pasek narzędzi to zestaw ikon reprezentujących wspólne polecenia. Aby uzyskać dostęp do
wybranego polecenia, kliknij odpowiednią ikonę na pasku narzędzi.

Standardowy pasek narzędzi znajduje się poniżej menu w górnej części każdego okna programu
należącego do pakietu Oracle Open Office. Na poniższym rysunku jest widoczny, patrząc od
góry, pasek narzędzi Standardowy, pasek narzędzi Formatowanie i pasek narzędzi Tabela.
Pasek narzędzi Tabela przedstawia ruchomy lub “pływający” pasek narzędzi, który otwiera się
wraz z umieszczeniem kursora na obszarze tabeli.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
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Porada – Zatrzymanie wskaźnika myszy nad ikoną paska narzędzi spowoduje wyświetlenie w
żółtym oknie nazwy polecenia reprezentowanego przez tę ikonę. Aby wyświetlić zaawansowaną
wskazówkę, naciśnij klawisze Shift+F1.

Wyświetlanie i ukrywanie pasków narzędzi
Większość pasków narzędzi pozostaje otwarta lub zamknięta w zależności od działań
użytkownika. Przykładowo, kliknięcie tabeli w dokumencie tekstowym spowoduje otworzenie
paska narzędzi Tabela. Wraz z kliknięciem poza obszarem tabeli ten pasek narzędzi zostanie
automatycznie zamknięty.

Programy pakietu Oracle Open Office zapamiętują stan, rozmiar i położenie pasków narzędzi.
Kliknięcie ikony Zamknij w “pływającym” pasku narzędzi spowoduje tymczasowe zamknięcie
tego paska. Pasek narzędzi będzie na stałe zamknięty po przejściu do kolejno pozycji
Widok→Paski narzędzi i wybraniu nazwy odpowiedniego paska. Aby włączyć pasek narzędzi
na nowo, kliknij to samo polecenie.

Aby wyświetlić ukryty pasek narzędzi, wybierz pozycje Widok→Paski narzędzi i kliknij nazwę
paska.

Przenoszenie i zmiana rozmiarów pasków narzędzi
Aby przenieść pasek narzędzi, przeciągnij uchwyt znajdujący się na lewej krawędzi
zakotwiczonego paska narzędzi lub paska tytułu “pływającego” paska narzędzi do wybranego
położenia na ekranie. Aby zakotwiczyć pasek narzędzi, przeciągnij go do krawędzi okna
programu.

Aby zmienić rozmiar “pływającego” paska narzędzi, przeciągnij krawędź wybranego paska.
Przykładowo, można zmienić układ paska narzędzi Tabela z poziomego na pionowy.

Aby wyświetlić lub ukryć ikony na pasku narzędzi, kliknij strzałkę znajdującą się na jego końcu,
wybierz opcję Widoczne przyciski i wybierz odpowiedni przycisk.

Aby dodać więcej poleceń do paska narzędzi, kliknij strzałkę znajdującą się na jego końcu i
wybierz opcję Dostosuj pasek narzędzi.

Skróty klawiszowe
Skróty klawiszowe umożliwiają szybkie przeprowadzanie najczęstszych zadań w programach
pakietu Oracle Open Office. Skróty klawiszowe to jeden lub więcej klawiszy na klawiaturze,
które należy nacisnąć w celu wypełnienia zadania. Aby na przykład zapisać dokument, naciśnij
klawisze Control+S. W systemie Mac OS X, należy posłużyć się klawiszem Command zamiast
Control. Dodatek zawiera listę najczęściej stosowanych skrótów klawiszowych.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
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Dostosowywanie poleceń menu, pasków narzędzi i
skrótów klawiszowych
Menu, paski narzędzi i skróty klawiszowe w programach pakietu Oracle Open Office można
dostosowywać, tworząc spersonalizowane środowisko pracy.

Aby dostosować te elementy, przejdź kolejno do pozycji Narzędzia→Dostosuj, a następnie
wybierz odpowiednią kartę. Więcej informacji na temat dostosowywania oprogramowania
można uzyskać po kliknięciu przycisku Pomoc.

Korzystanie z kreatorów
Kreator to seria okien dialogowych, które przeprowadzają użytkownika przez proces tworzenia
szablonu, np. pisma służbowego. Aby uruchomić dowolny kreator, wybierz kolejno pozycje
Plik→Kreatory w dowolnym programie pakietu Oracle Open Office.

Uwaga – Niektóre z kreatorów zostaną uruchomione automatycznie, np. przy próbie utworzenia
dokumentu w formacie bazy danych lub eksportowania arkusza do formatu HTML.

Korzystanie z szablonów
Programy pakietu Oracle Open Office wykorzystują szablony do przechowywania układu i
stylu formatowania dokumentów. Nowy dokument można sformatować, stosując do tego jeden
z wielu specyficznych szablonów.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
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Aby wyświetlić dostępne szablony, wybierz pozycje Plik→Nowy→Szablony i dokumenty i
kliknij ikonę Szablony. Dwukrotnie kliknij folder. Kliknij polecenie Otwórz, aby otworzyć
nowy dokument oparty na wybranym szablonie. Kliknij polecenie Edytuj, aby edytować
szablon.

Z pakietem Oracle Open Office są dostarczane niżej wymienione szablony. Niektóre szablony
zawierają interaktywne elementy, takie jak symbole zastępcze tekstu, który ma być
wprowadzony, lub powodują wyświetlenie okien dialogowych, w których można zmienić
standardową treść.

■ Korespondencja służbowa: różnorodne listy, faksy, notatki
■ Nauka: referat naukowy, prezentacja naukowa, plan zajęć, praca magisterska
■ Finanse: szereg arkuszy do projektów budżetowych, w tym budżetów domowych, pożyczek i

hipotek, planowania projektów, zarządzania akcjami
■ Formularze i umowy: umowa sprzedaży, różne formularze notatek biurowych
■ MediaWiki: szablon używany w rozszerzeniu MediaWiki Publisher
■ Inne: książka, płyta CD, broszura do płyty CD, konkursy, eliminacje, plakaty wydarzeń,

świadectwo podarunku, turniej ligi, kalendarze, gazeta, plan zmiany
■ Inne dokumenty służbowe: papier milimetrowy, faktury, protokół, oświadczenia prasowe,

raport
■ Korespondencja i dokumenty osobiste: wizytówki, koperty, listy, faksy, życiorys
■ Tła prezentacji: w różnych kolorach do zastosowania w podstawowych slajdach
■ Prezentacje: różnorodne raporty firmowe, raporty finansowe, protokół, plan marketingowy,

sprawozdanie z projektu, prezentacja handlowa itd.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
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Wstawianie obrazów
Aby wstawić obraz z pliku, umieść kursor w miejscu, w którym obraz ma być wstawiony, a
następnie wybierz pozycje Wstaw→Obraz→Z pliku. W oknie dialogowym Wstaw grafikę
wybierz obraz i kliknij przycisk Otwórz.

Możesz osadzić obraz w pliku dokumentu lub wstawić łącze do obrazu. Aby wstawić łącze do
obrazu, włącz pole wyboru Łącze w oknie dialogowym Wstaw grafikę, a następnie kliknij
przycisk Otwórz.

Osadzony obraz lub łącze do
obrazu,
zalety (+) i wady (−) Obraz osadzony Łącze do obrazu

+ Dokument i obraz są
przechowywane razem, nawet
podczas rozsyłania pliku
dokumentu.

Dokumenty mają mały rozmiar
nawet z dużą liczbą obrazów.
Zmiany w obrazach źródłowych są
widoczne po ponownym otwarciu
dokumentu.

− W przypadku większej liczby
obrazów dokument może osiągnąć
rzeczywiście duże rozmiary.
Osadzone obrazy nie są
aktualizowane podczas zmian w
obrazach źródłowych.

Podczas rozsyłania pliku ODF
należy uwzględnić obrazy z
zachowaniem tej samej struktury
folderów.

Można zmienić łącza do obrazów na obrazy osadzone poprzez wybór pozycji Edycja→Łącza.
Wybierz obrazy i kliknij przycisk Przerwij łącze.

▼ Dodawanie obrazu do galerii
Galeria pakietu Oracle Open Office zawiera standardowe obrazy, które można wstawić do
slajdu.

Korzystanie z menu, pasków narzędzi i skrótów klawiszowych
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Wybierz Narzędzia→Galeria.

Wybierz kompozycję z listy po lewej stronie.

Wybierz grafikę, którą chcesz wstawić.

Przeciągnij grafikę do dokumentu.

Praca na dokumentach
Można tworzyć, otwierać, drukować i zapisywać dokumenty w podobny sposób, jak dzieje się to
w innych programach biurowych.

Aby utworzyć nowy dokument, w programie pakietu Oracle Open Office wybierz pozycje
Plik→Nowy, a następnie typ dokumentu, który ma być utworzony.

Aby otworzyć istniejący dokument, w programie pakietu Oracle Open Office wybierz pozycje
Plik→Otwórz.

Można również otworzyć dokument zapisany w formacie innym niż format dokumentów
pakietu Oracle Open Office, np. dokument programu Microsoft Excel (.xls).

Porada – W menu Plik dowolnego programu pakietu Oracle Open Office wyświetlana jest lista
ostatnio zapisywanych plików. Aby otworzyć jeden z tych plików, wybierz kolejno pozycje
Plik→Poprzednie dokumenty i kliknij nazwę pliku.

Dokumenty pakietu Oracle Open Office można zapisać w wielu różnych formatach, wliczając w
to większość formatów pakietu Microsoft Office.

1

2

3

4

Praca na dokumentach
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W programie pakietu productshortname; wybierz kolejno opcje Plik→Zapisz lub Plik→Zapisz
jako.

W oknie rodzaju pliku wybierz format, w którym ma zostać zapisany dokument, np. format
programu Microsoft Word.

Uwaga – Aby się upewnić, że dane nie zostały utracone, zapisz dokument w jednym z formatów
pliku OpenDocument.

Eksportowanie dokumentów
Istnieje różnica między zapisywaniem dokumentu, a eksportowaniem go do innego typu
formatu. Po zapisaniudokumentu pakietu Oracle Open Office za pomocą poleceń Plik→Zapisz
lub Plik→Zapisz jako dokument można później otworzyć w pakiecie. Przykładem może być
dokument tekstowy OpenDocument (ODT) zapisany w formacie pliku programu Microsoft
Word, który również może zostać odczytany w pakiecie Oracle Open Office.

Podczas eksportu dokumentu jego zawartość nie jest zmieniana. Oprogramowanie Oracle Open
Office utworzy kopię bieżącego dokumentu w formacie wybranym do eksportu. Przykładowo,
można eksportować obiekt z dokumentu programu Draw do formatu JPEG. Podczas eksportu
informacje zostają utracone z powodu ograniczeń formatu eksportowanego pliku.

Aby eksportować dokument do innego formatu, w programie pakietu Oracle Open Office
wybierz pozycje Plik→Eksportuj. W oknie rodzaju pliku wybierz format, w którym ma zostać
zapisany eksportowany dokument, np. dokument HTML.

Wysyłanie dokumentów
Aby wysłać bieżący dokument jako załącznik e-mail, kliknij ikonę Dokument jako e-mail. na
standardowym pasku narzędziowym. Domyślny program poczty e-mail w danym systemie
operacyjnym otworzy i wyświetli pustą wiadomość e-mail z dokumentem umieszczonym w niej
w formie załącznika.

Przejdź kolejno do pozycji Plik→Wyślij, aby wysłać bieżący dokument w formacie czytelnym
dla użytkowników programu Microsoft Office.

Przykładowo, można zdecydować o przesłaniu bieżącego dokumentu tekstowego w formacie
programu Microsoft Word. Po użyciu tego polecenia zostanie utworzona tymczasowa kopia
bieżącego dokumentu w formacie czytelnym dla użytkowników programu Microsoft Word, a
następnie zostanie otwarte okno, w którym należy wpisać adres e-mail odbiorcy. Plik
tymczasowy zostanie przesłany jako załącznik.

Praca na dokumentach

Podręcznik dla początkujących użytkowników pakietu Oracle Open Office 3 • Wrzesień 201032



Praca z dokumentami PDF
Format PDF nadaje się do publikowania dokumentów w sposób, który pozwala na zachowanie
układu i projektu na większości ekranów. Bieżący dokument można eksportować do formatu
PDF za pomocą polecenia menu lub ikony na pasku narzędzi Standardowy.

1. Przejdź kolejno do pozycji Plik→Eksportuj jako PDF.

2. W oknie dialogowym Opcje PDF określ wybrane opcje i naciśnij przycisk Eksportuj.

3. Wpisz nową nazwę dokumentu w polu nazwy pliku.

4. Kliknij Eksportuj.

Porada – Jeśli nie ma potrzeby zmiany opcji eksportowania pliku do formatu PDF, kliknij ikonę
PDF na pasku narzędzi Standardowy. Eksport do pliku PDF odbywa się z użyciem opcji
uprzednio ustawionych w oknie dialogowym, z wyjątkiem strony karty Bezpieczeństwo, która
zawsze jest otwierana z domyślnymi ustawieniami.

Format pliku PDF został utworzony pod kątem publikowania dokumentów z zachowaniem
spójnego układu na wszystkich platformach i w różnych systemach. Format nie został
natomiast opracowany z myślą o możliwości edytowania. Jest jednak możliwe otwarcie pliku
PDF jako rysunku i edytowania go w podstawowym zakresie. Służy do tego funkcja PDF Import
pakietu Oracle Open Office. Można na przykład zmienić datę lub poprawić mały błąd w
pisowni. Edycję w bardziej zaawansowanym zakresie lepiej jest przeprowadzić podczas pracy
nad oryginalnym plikiem.

1. W dowolnym module wybierz pozycje Plik→Otwórz, aby otworzyć plik PDF.

2. Plik PDF zostaje otwarty w programie Oracle Open Office Draw. Można na przykład
zamienić obraz lub dwukrotnie kliknąć pole tekstowe, aby edytować tekst.

3. Po zakończeniu wybierz pozycje Plik→Eksportuj jako PDF w celu utworzenia nowego pliku
PDF.

Za pomocą funkcji PDF Import można utworzyć hybrydowe pliki PDF. Pliki hybrydowe są to
pliki PDF z osadzoną zawartością w formacie ODF. Większość czytników plików PDF
umożliwia wyświetlenie plików hybrydowych jak normalnych plików PDF. Gdy jednak inny
użytkownik pakietu Oracle Open Office z włączoną funkcją PDF Import otworzy plik
hybrydowy, część w formacie ODF zostanie otwarta w tym samym module (Writer, Calc,
Impress lub Draw), który został użyty do utworzenia pliku hybrydowego. Dostępne są
wszystkie funkcje edycji macierzystego modułu Oracle Open Office.

Praca na dokumentach
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1. Aby utworzyć plik hybrydowy PDF na podstawie bieżącego dokumentu, wybierz pozycje
Plik→Eksportuj jako PDF.

2. Kliknij kartę Ogólne, aby otworzyć stronę karty.

3. Włącz opcję Utwórz plik hybrydowy. Kliknij Eksportuj.

Funkcja eksportu PDF w pakiecie Oracle Open Office zapewnia opcjonalną obsługę standardu
PDF/A-1a dla dokumentów archiwalnych. Jeśli konieczne jest utworzenie pliku PDF ze względu
na długoterminowe potrzeby archiwizacji, włącz tę opcję na karcie Ogólne. Te pliki mogą
uzyskać bardzo duży rozmiar, ponieważ zawierają informacje o strukturze oraz muszą
obejmować wszystkie czcionki używane w dokumencie.

Pomoc
Pakiet Oracle Open Office 3 jest wyposażony w kilka różnych systemów pomocy dostępnych w
czasie pracy:

■ Pomoc aplikacji
■ Agent pomocy
■ Wskazówki
■ Zaawansowane wskazówki
■ Pomoc kontekstowa

Pomoc
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Istnieje kilka metod skorzystania z zainstalowanej pomocy pakietu Oracle Open Office:

■ Wybierz kolejno opcje Pomoc→Pomoc Oracle Open Office lub naciśnij klawisz F1.

To polecenie powoduje otwarcie przeglądarki pomocy do pakietu Oracle Open Office.

■ Kliknij przycisk Pomoc w dowolnym oknie dialogowym, aby wyświetlić pomoc danego dla
danego okna.

■ Kliknij ikonę agenta pomocy wyświetlając automatycznie wskazówki podczas
wykonywania złożonego zadania.

■ Zatrzymanie wskaźnika myszy na poleceniu menu lub dowolnej ikonie spowoduje
wyświetlenie wskazówki.

Aby zapoznać się z krótkim opisem polecenia lub ikony, naciśnij kombinację klawiszy
Shift+F1. Zostanie wyświetlona wskazówka zaawansowana.

Pomoc
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■ Więcej informacji na temat pomocy technicznej można uzyskać po wybraniu kolejno
pozycji Pomoc→Pomoc techniczna.

Wspólne polecenia aplikacji
Wszystkie programy pakietu Oracle Open Office mają podobny wygląd i wspólną część
poleceń. W każdym programie pakietu Oracle Open Office można otworzyć dowolny
dokument zapisany w obsługiwanym formacie plików. Przykładowo, w otwartym dokumencie
programu Calc można przejść do kolejno pozycji Plik→Otwórz i wybrać dokument programu
Microsoft Word. Dokument programu Word zostanie automatycznie otwarty w programie
Oracle Open Office Writer.

Uwaga – Użytkownicy przyzwyczajeni do korzystania z pakietu Microsoft Office znajdą więcej
informacji w Rozdział 10, “Przejście z pakietu Microsoft Office”.

Wszystkie otwarte dokumenty pakietu Oracle Open Office są wyświetlane na pasku menu
systemu Windows.

Wiele poleceń menu Plik jest wspólnych dla wszystkich programów pakietu Oracle Open
Office.

Przykłady integracji programów należących do pakietu
Oracle Open Office

Programy pakietu Oracle Open Office są ze sobą ściśle zintegrowane, umożliwiając łatwe użycie
zawartości jednej aplikacji w innej. W poniższych sekcjach przedstawiono zaledwie kilka
przykładów korzyści, jakie można uzyskać dzięki integracji programów. Pomiędzy programami
pakietu Oracle Open Office 3 może zachodzić znacznie więcej interakcji.

Zakres komórek programu Calc można wstawić do dokumentu programu Writer, dzięki czemu
z każdą modyfikacją arkusza nastąpi automatyczna aktualizacja danych. Skopiuj zakres
komórek do schowka, a następnie wybierz pozycje Edycja→Wklej specjalnie i wybierz opcję
DDE.

Aby wstawić konspekt tekstu do prezentacji, wybierz pozycje Plik→ Wyślij→Konspekt do
prezentacji. Każdy styl paragrafu Nagłówek 1 w dokumencie tekstowym tworzy nowy slajd.
Style nagłówków następujące w hierarchii nagłówków po stylu Nagłówek 1 są wyświetlane na
slajdzie w postaci wypunktowania.

Metody “przeciągnij i upuść” można używać do kopiowania tekstu i obiektów pomiędzy
programami pakietu Oracle Open Office.

Wspólne polecenia aplikacji
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Tworzenie wzorów w module Oracle Open Office Math
Moduł Oracle Open Office Math służy do tworzenia i wyświetlania wzorów w dokumentach.
Aplikacja Math nie oblicza wyników wzorów. Aby utworzyć wzór służący do obliczeń, użyj
arkusza kalkulacyjnego Oracle Open Office Calc.

W module Oracle Open Office Math znajduje się pasek narzędzi z symbolami umożliwiającymi
tworzenie złożonych wzorów.

Więcej informacji na temat korzystania z modułu Oracle Open Office Math, w tym na temat
przykładowych wzorów, można znaleźć w opcji pomocy danej aplikacji.

Praca z makrami
Wiele zadań w ramach tego samego dokumentu może być wykonywanych przez pakiet Oracle
Open Office w wyniku uruchomienia makra. Poszczególne czynności wykonywane
jednokrotnie przez użytkownika są rejestrowane za pomocą rejestratora makr. Użytkownik w
trakcie dalszej pracy wydaje polecenie uruchomienia makra, co powoduje wykonanie
wymaganych czynności zarejestrowanych w ramach makra w pakiecie Oracle Open Office. W
oknie dialogowym Konfiguruj można przypisać makro do nowego polecenia menu, do ikony
lub klawisza.

Do edycji makra służy zintegrowane środowisko programistyczne (IDE) programu Oracle
Open Office Basic. Dokumentacja do języka programowania Basic znajduje się na stronie
BASIC Programming Guide (Podręcznik programowania języka BASIC).

Przykłady integracji programów należących do pakietu Oracle Open Office
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Środowiska IDE programu Basic można użyć także do tworzenia własnych funkcji modułu
Calc. Więcej informacji zawiera system pomocy do programów Basic i Calc.

Przykłady integracji programów należących do pakietu Oracle Open Office
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Oracle Open Office Writer

Oracle Open Office Writer to edytor tekstu zapewniający możliwość użycia elastycznych tabel,
wstawiania ramek do wyodrębnienia tekstu, podziału na kolumny, dzięki któremu można
uzyskać profesjonalny układ tekstu oraz tworzenia indeksów, spisu treści i formularzy.
Obejmuje on również obsługę grafiki i wbudowaną funkcję eksportu plików do formatu PDF.
Za jego pomocą można odczytywać, edytować, drukować i zapisywać pliki programu Microsoft
Word. Bez względu na to, czy trzeba napisać krótką notatkę, czy sporządzić obszerny raport ze
spisem treści, wykresami i indeksem, w programie Oracle Open Office Writer będzie to łatwe.

Tworzenie nowego dokumentu tekstowego
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Aby utworzyć nowy pusty dokument tekstowy, w programie pakietu Oracle Open Office
wybierz pozycje Plik→Nowy→Dokument tekstowy.

Nowy dokument zostaje utworzony na podstawie domyślnego szablonu dla dokumentów
tekstowych. Domyślny szablon definiuje ustawienia domyślne pliku, np. typ czcionki, rozmiar
czcionki, język, marginesy itp. Więcej informacji na temat domyślnych szablonów i sposobów
ich modyfikacji można znaleźć w opcji pomocy danej aplikacji.

Tworzenie nowego dokumentu tekstowego
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Można również utworzyć dokument tekstowy na podstawie innego szablonu niż domyślny:

1. W dowolnym programie pakietu Oracle Open Office wybierz opcje Plik→Nowy→Szablony
i dokumenty.

2. W lewym panelu okna dialogowego Szablony i dokumenty kliknij ikonę Szablony.
3. Kliknij dwukrotnie kategorię szablonów w środkowym panelu.

Uwaga – Aby wyjść z kategorii szablonów, kliknij lewą ikonę strzałki znajdującą się w górnej
części okna dialogowego.

4. Wybierz szablon, którego chcesz użyć, i kliknij pozycję Otwórz.

Można także utworzyć własny szablon. Opcja pomocy danej aplikacji zawiera instrukcje
zapisywania dowolnego dokumentu jako szablonu.

Kreator listu, faksu lub planu spotkania przeprowadza użytkownika przez proces tworzenia
odpowiedniego typu dokumentu. Aby utworzyć nowy pusty szablon za pomocą kreatora, w
programie pakietu Oracle Open Office wybierz pozycje Plik→Kreatory oraz odpowiedni rodzaj
dokumentu do utworzenia i postępuj według instrukcji.

Wstawianie i edytowanie tekstu dokumentu
Program Oracle Open Office Writer dostarcza kilku narzędzi interaktywnych zwiększających
wydajność pisania:

W trakcie pisania narzędzie autokorekty automatycznie poprawia częste błędy pisowni, np.
“sie” zostaje poprawione na “się”.

Wstawianie i edytowanie tekstu dokumentu
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Domyślnie narzędzie uzupełniania wyrazów gromadzi w pamięci zapisane długie wyrazy. Po
ponownym rozpoczęciu pisania takiego wyrazu w pakiecie Oracle Open Office będzie on
automatycznie uzupełniany. Aby zaakceptować sugerowany wyraz, należy nacisnąć klawisz
Enter lub kontynuować pisanie.

Narzędzia automatyczne można wyłączyć, posługując się poleceniami Narzędzia→Opcje
autokorekty. Informacje szczegółowe znajdują się w opcji pomocy danej aplikacji.

Zaznaczanie tekstu za pomocą myszy
■ Aby zaznaczyć ustęp tekstu, kliknij początek ustępu, przytrzymaj naciśnięty lewy przycisk

myszy i przeciągnij nim do końca tekstu.
Można również kliknąć początek ustępu, przenieść kursor myszy na koniec tekstu,
przytrzymać naciśnięty klawisz Shift i ponownie kliknąć myszą.

■ Aby zaznaczyć pojedynczy wyraz, kliknij dwukrotnie w dowolnym miejscu tego wyrazu.
■ Aby zaznaczyć całe zdanie, kliknij trzykrotnie w dowolnym miejscu tego zdania.
■ Aby zaznaczyć cały akapit, kliknij czterokrotnie w małych odstępach czasu.
■ Aby dołączyć do zaznaczonego tekstu więcej ustępów, przytrzymaj naciśnięty klawisz

Control, a następnie zaznacz kolejny ustęp tekstu.

Zaznaczanie tekstu za pomocą klawiatury
■ Aby zaznaczyć cały dokument, naciśnij klawisze Control+A.

Jeśli kursor znajduje się w tabeli umieszczonej w dokumencie tekstowym, pierwsze
naciśnięcie klawiszy Control+A spowoduje zaznaczenie bieżącej komórki (jeśli komórka
ma jakąkolwiek zawartość), kolejne naciśnięcie kombinacji Control+A skutkuje
zaznaczeniem tabeli, następne naciśnięcie klawiszy Control+A prowadzi do zaznaczenia
całości tekstu z uwzględnieniem wszystkich tabel.

■ Aby zaznaczyć pojedynczy wyraz po jednej ze stron kursora, przytrzymaj naciśnięte klawisze
Control+Shift, a następnie naciśnij klawisz ze strzałką w lewo ← lub klawisz ze strzałką w
prawo →.

■ Aby zaznaczyć pojedynczy znak po jednej ze stron kursora, przytrzymaj naciśnięty klawisz
Shift, a następnie naciśnij klawisz ze strzałką w lewo ← lub klawisz ze strzałką w prawo →.
Aby zaznaczyć więcej niż jeden znak, naciśnij ponownie klawisz strzałki, cały czas
przytrzymując klawisz Shift.

■ Aby zaznaczyć pozostały tekst wiersza na lewo od kursora, przytrzymaj naciśnięty klawisz
Shift, a następnie naciśnij klawisz Home.

■ Aby zaznaczyć pozostały tekst wiersza na prawo od kursora, przytrzymaj naciśnięty klawisz
Shift, a następnie naciśnij klawisz End.
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Kopiowanie, wklejanie i usuwanie tekstu dokumentu
Tekst można kopiować z jednego miejsca do innego w obrębie tego samego dokumentu lub
pomiędzy różnymi dokumentami. W tym celu można skorzystać z poleceń Wytnij, Kopiuj i
Wklej z menu, kliknąć ikony na pasku narzędzi Standardowy lub użyć klawiatury.

Porada – Przejdź kolejno do pozycji Edycja→Wklej specjalnie i wklej niesformatowany tekst,
aby skopiować sam tekst bez jego formatowania.

Wyszukiwanie i zamiana tekstu
Do wyszukiwania i zamiany słów w dokumencie tekstowym użyj funkcji Znajdź i zamień
programu Oracle Open Office Writer.

Pasek narzędzi Znajdź jest dostępny w górnym prawym rogu okna pakietu Oracle Open Office.

Kliknij pole tekstowe na pasku narzędzi Znajdź i wpisz tekst do wyszukania. Następnie naciśnij
klawisz Enter lub kliknij strzałkę w dół w celu znalezienia i podświetlenia pierwszego
wystąpienia poniżej bieżącego położenia kursora. Naciśnij ponownie klawisz Enter, aby znaleźć
kolejne wystąpienie itd. Naciśnij kombinację klawiszy Shift+Enter lub kliknij strzałkę w górę w
celu wyszukania w odwrotnym kierunku.

Okno dialogowe Znajdź i zamień zapewnia dalsze opcje wyszukiwania i zastępowania tekstu.

1. Przejdź kolejno do pozycji Edycja→Znajdź i zamień.

2. W polu Znajdź wpisz tekst do wyszukania w dokumencie.

Uwaga – Można również zaznaczyć słowo lub frazę do wyszukania w dokumencie
tekstowym, a następnie przejść kolejno do pozycji Edycja→Znajdź i zamień. Zaznaczony
tekst zostanie automatycznie wprowadzony do pola wyszukiwania.

3. Kliknij przycisk Znajdź, aby rozpocząć wyszukiwanie.

4. W polu Zamień wpisz zamienny tekst, a następnie kliknij przycisk Zamień.
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Porada – Tekst można również wyszukiwać (i zastępować), korzystając z symboli
wieloznacznych. Rozwiń okno dialogowe, aby wyświetlić więcej opcji, a następnie zaznacz
pole wyboru Regularne wyrażenie. Więcej informacji dotyczących tego zagadnienia oraz
sposobów wyszukiwania (i zamiany) można znaleźć w opcji pomocy danej aplikacji.

Sprawdzanie pisowni
Program Writer jest wyposażony w funkcję sprawdzania błędów pisowni w trakcie pisania lub
też sprawdzania błędów w całym dokumencie.

▼ Sprawdzanie pisowni w trakcie pisania
Program Writer może ostrzegać przed potencjalnymi błędami w trakcie pisania.

Aby włączyć tę funkcję, kliknij ikonę Automatyczne sprawdzanie pisowni na pasku narzędzi
Standardowy.

Po włączeniu tej funkcji potencjalne błędy pisowni będą zaznaczane czerwonymi falistymi
podkreśleniami.

Aby wyświetlić proponowaną pisownię, kliknij słowo z czerwonym podkreśleniem prawym
przyciskiem myszy.

Przeprowadź jedną z poniższych czynności:

■ Wybierz jedną z sugerowanych propozycji poprawnego słowa z górnej części menu
kontekstowego.

Błędne słowo zostanie zastąpione wybranym słowem.

1
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■ Wybierz jedną z sugerowanych propozycji poprawnego słowa z podmenu autokorekty.

Błędne słowo zostanie zastąpione wybranym słowem. Obydwa słowa zostaną
automatycznie dodane do listy zastąpień narzędzia autokorekty. W przypadku ponownego
popełnienia tego samego błędu pisowni program Writer dokona automatycznej poprawy
pisowni.

■ Wybierz pozycję Sprawdzanie pisowni, aby otworzyć okno dialogowe tej funkcji.

Okno dialogowe Pisownia zostało opisane w sekcji Sprawdzanie pisowni w całym
dokumencie.

■ Aby dodać słowo do jednego ze słowników, wybierz pozycję Dodaj i kliknij nazwę słownika.

Wyraz nie pozostanie zaznaczony jako potencjalnie zawierający błąd pisowni, o ile dany
słownik nie jest wyłączony w oknie dialogowym Opcje.

Jeśli słowo zostanie mylnie wprowadzone do słownika, można poddać edycji zawartość
słownika. Instrukcji postępowania w takim przypadku należy szukać w indeksie pomocy
pod pozycją “słowniki; edytowanie”.

Uwaga – Słowniki definiowane przez użytkownika mogą zawierać ograniczoną liczbę
wpisów, można jednak utworzyć dowolną liczbę słowników.

▼ Sprawdzanie pisowni w całym dokumencie
Można także skorzystać z narzędzia sprawdzania pisowni w całym dokumencie po zakończeniu
edycji. Narzędzie sprawdzania pisowni rozpoczyna sprawdzanie od bieżącej pozycji kursora lub
od początku zaznaczonego tekstu.

Uwaga – W przypadku zainstalowania rozszerzenia do sprawdzania gramatyki po sprawdzeniu
pisowni przeprowadzone zostanie sprawdzanie gramatyki. Po włączeniu funkcji
automatycznego sprawdzania pisowni błędy gramatyczne są podkreślane na niebiesko, a błędy
ortograficzne na czerwono.

Kliknij miejsce w obszarze dokumentu lub zaznacz tekst do sprawdzenia.

Wybierz kolejno opcje Narzędzia→Pisownia i gramatyka.
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W przypadku znalezienia ewentualnego błędu pisowni w oknie dialogowym narzędzia
sprawdzania pisowni i gramatyki zostanie wyświetlona propozycja zmiany.

Przeprowadź jedną z poniższych czynności:

■ Kliknij przycisk Zamień, aby zaakceptować zmianę bieżącego słowa.

■ Kliknij przycisk Zamień wszystkie, aby zaakceptować zmianę tego słowa dla całego
dokumentu.

■ Kliknij przycisk Autokorekta, aby zaakceptować zmianę tego słowa w funkcji autokorekty
dla tekstu we wszystkich następnych dokumentach.

■ Aby zamienić słowo na proponowaną wersję, zamień błędne słowo w górnym polu na
prawidłową wersję i kliknij przycisk Zamień.

■ Aby jednorazowo zignorować bieżącą propozycję i kontynuować sprawdzanie pisowni,
kliknij przycisk Ignoruj.

■ Aby zignorować bieżącą propozycję dla całego dokumentu i kontynuować sprawdzanie
pisowni, kliknij przycisk Ignoruj wszystkie.

Rozwiązywanie problemów dotyczących sprawdzania pisowni
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Jeśli sprawdzanie pisowni nie działa, sprawdź, czy są spełnione poniższe wymagania:

■ Czy słownik do sprawdzania pisowni jest zainstalowany?
Przejdź do pozycji Narzędzia→Opcje→Ustawienia językowe→Pisownia. (W systemach
Mac OS X ścieżka rozpoczyna się od pozycji Oracle Open Office→Preferencje, a nie od opcji
Narzędzia→Opcje).
Kliknij przycisk Edytuj, aby otworzyć okno dialogowe Edytuj moduły — patrz rysunek
powyżej. Sprawdź, czy słownik pisowni został zainstalowany dla danego języka. Jeśli nie,
kliknij łącze Pobierz więcej słowników online, a następnie pobierz i zainstaluj brakujące
pliki. Sprawdź ponadto, czy słownik został uaktywniony (jest zaznaczony).

■ Czy słownik został uaktywniony?
W polu menu sterowania językiem (patrz przykład powyżej) sprawdź, czy włączony został
odpowiedni język. Jeśli nie, słownik języka jest niezainstalowany lub nieuaktywniony.

■ Czy tekst jest sformatowany w prawidłowym języku?
Umieść kursor w miejscu, w którym ma być wykonane sprawdzanie pisowni. Sprawdź pasek
stanu pod oknem dokumentu. Kliknij pole paska stanu w celu wyświetlenia menu do
zmiany języka.
Aby zastosować inny język, zaznacz tekst i zmień język, posługując się poleceniami
Format→Znak→Czcionka.

■ Czy zostało włączone automatyczne sprawdzanie pisowni?
Ikona Automatyczne sprawdzanie pisowni na pasku narzędzi Standardowy musi być
uaktywniona.

Formatowanie tekstu dokumentu
Tekst można formatować ręcznie lub za pomocą stylów. Obydwie metody zapewniają kontrolę
nad rozmiarem i rodzajem czcionki, kolorem, ustawieniem tekstu oraz odstępami.
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Formatowanie ręczne ma zastosowanie tylko do zaznaczonego tekstu, podczas gdy
formatowanie za pomocą stylu dotyczy wszystkich partii dokumentu, w których wykorzystano
dany styl.

W pakiecie Oracle Open Office korzystanie ze stylów do formatowania tekstu jest proste.
Stosując style w tekście — wbudowane lub zdefiniowane przez siebie — można później w łatwy i
szybki sposób zmienić wygląd i układ dokumentu.

Uwaga – Wszędzie tam, gdzie to możliwe, zaleca się stosowanie stylów do formatowania.

Formatowanie ręczne tekstu dokumentu
Do prostego formatowania, np. zmiany rozmiaru i koloru tekstu, należy posłużyć się ikonami
na pasku formatowania.

Zaznacz wybrany tekst i wprowadź zmiany.

■ Aby zmienić rodzaj używanej czcionki, wybierz lub wpisz nazwę czcionki w polu nazw
czcionek.

■ Aby zmienić rozmiar tekstu, wybierz lub wpisz rozmiar w polu rozmiaru czcionek.
■ Aby dodać lub usunąć wypunktowanie lub numerację z listy, kliknij ikonę Włącz/wyłącz

numerację lub Włącz/wyłącz wypunktowanie.
■ Do zmiany wcięcia tekstu posłuż się ikonami wcięcia.
■ Aby zmienić kolor tekstu, kliknij ikonę Kolor czcionki.
■ Aby zmienić kolor tła tekstu, kliknij ikonę Kolor tła lub Wyróżnienie.

Więcej informacji na temat ikon Kolor tła i Wyróżnienie można znaleźć w opcji pomocy
danej aplikacji.

Formatowanie tekstu za pomocą stylów
Style programu Writer zawierają domyślne formatowanie znaków, akapitów, stron,
obramowania i list. Styl to zbiór opcji formatowania, np. rodzaju i rozmiaru czcionki. Styl
definiuje ogólny wygląd tekstu i układ dokumentu.

Style stanowią część używanych szablonów. W nowym dokumencie wszystkie style są
definiowane przez domyślny szablon tekstu. Więcej informacji na ten temat można uzyskać po
naciśnięciu klawisza F1, otwarciu opcji pomocy i wpisaniu odsyłacza “style; style i szablony”.

Okno Style i formatowanie umożliwia łatwe zastosowanie stylów formatowania. Aby otworzyć
okno Style i formatowanie, przejdź kolejno do pozycji Formatowanie→Style i formatowanie.

Wstawianie i edytowanie tekstu dokumentu

Podręcznik dla początkujących użytkowników pakietu Oracle Open Office 3 • Wrzesień 201048



■ Aby przypisać styl paragrafu, kliknij ikonę Style akapitów u góry okna Style i formatowanie,
a następnie kliknij dwukrotnie styl na liście.

■ Aby przypisać styl znaków do tekstu, zaznacz tekst, a następnie kliknij ikonę Style znaków w
górnej części okna Style i formatowanie oraz dwukrotnie kliknij styl na liście.

■ Aby zmienić układ wszystkich stron, które korzystają z tego samego stylu co bieżąca strona,
należy kliknąć ikonę Style strony w górnej części okna Style i formatowanie oraz dwukrotnie
kliknąć styl na liście.

Śledzenie zmian
Za pomocą funkcji Śledzenie zmian grupy robocze mogą w łatwy sposób pracować
jednocześnie nad tym samym dokumentem.

Korzyści z zastosowania funkcji Śledzenia zmian to między innymi:

■ Wiele osób może edytować ten sam dokument. Wszystkie wprowadzone zmiany mogą być
włączone do jednego końcowego dokumentu.

■ Użytkownicy edytujący dokument mają możliwość dodawania komentarzy do dyskusji,
pytań i odpowiedzi.

Aby włączyć funkcję Śledzenie zmian w bieżącym dokumencie, wybierz pozycje
Edycja→Zmiany→Rejestruj.

Wszystkie zmiany wprowadzone później zostaną zarejestrowane. Aby wyświetlić zmiany,
wybierz pozycje Edycja→Zmiany→Pokaż, które domyślnie powinny być uaktywnione.

Przestroga – Podczas edycji lub usuwania tekstu z uaktywnionym śledzeniem zmian oryginalny
tekst pozostaje widoczny, ale jest przekreślony. Należy pamiętać, aby unikać wysyłania
dokumentów, które zawierają niepożądane informacje.
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Korzystanie z Nawigatora
Nawigator to narzędzie, które umożliwia szybkie poruszanie się po strukturze dokumentu. W
oknie narzędzia wyświetlana jest lista obiektów znajdujących się w dokumencie,
posortowanych w poszczególnych kategoriach. Aby przejść do wybranego obiektu w
dokumencie, należy dwukrotnie kliknąć ten element w oknie Nawigator. Aby uzyskać dostęp do
menu poleceń, można użyć menu kontekstowego obiektu w oknie narzędzia Nawigatora. Aby
otworzyć okno narzędzia Nawigator, należy nacisnąć klawisz F5.

■ Aby wyświetlić zawartość tej kategorii, należy kliknąć symbol plusa obok nazwy kategorii.
■ Aby wyświetlić zawartość kategorii w oknie narzędzia Nawigator, należy zaznaczyć

kategorię, a następnie kliknąć ikonę Widok zawartości.

Uwaga – Aby wyświetlić całą zawartość, należy ponownie kliknąć ikonę Widok zawartości.

■ Aby szybko przejść do danego obiektu w dokumencie, należy dwukrotnie kliknąć pozycję z
listy w oknie narzędzia Nawigator.

■ Aby edytować właściwości obiektu, należy kliknąć prawym klawiszem myszy wybrany
obiekt.
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Porada – W przypadku dokumentu tekstowego, w trybie Widok zawartości można użyć
nagłówków w celu przeciągania i upuszczania całych rozdziałów w inne miejsca w dokumencie.
Więcej informacji na temat narzędzia Nawigator można uzyskać w opcji pomocy danej
aplikacji.

Narzędzie Nawigator można zakotwiczyć na krawędzi okna dowolnego dokumentu. Aby
odkotwiczyć narzędzie Nawigator od krawędzi okna, należy dwukrotnie kliknąć szary obszar
zakotwiczonego okna narzędzia Nawigator. Aby zmienić rozmiar okna narzędzia Nawigator,
należy przeciągnąć jego krawędzie.

Korzystanie z tabel w dokumentach tekstowych
Tabele umożliwiają przedstawianie oraz organizację ważnych informacji w wierszach oraz
kolumnach w czytelny sposób. Można połączyć komórki tabeli i utworzyć większy kontener.
Możliwe jest także wstawianie obrazów, tabeli szczegółowych lub innych obiektów. W tabelach
tekstowych można wykonywać obliczenia za pomocą wielu formuł i funkcji znanych z arkuszy
kalkulacyjnych. Format i układ tabeli tekstowych łatwo zmienić.

Ten rozdział zawiera opis macierzystych tabeli programu Writer. Jeśli niezbędne są wszystkie
funkcje z programu Calc, obszar arkusza kalkulacyjnego można przekopiować do dokumentu
tekstowego. Więcej informacji o tabelach i arkuszach kalkulacyjnych znajduje się w
zainstalowanej pomocy.

▼ Wstawianie tabel w dokumentach programu Writer
Wybierz Tabela→Wstaw→Tabela.

W polu Rozmiar należy podać liczbę wierszy oraz kolumn tabeli.
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(Opcjonalne)Aby użyć standardowego układu tabeli, należy kliknąć polecenie Autoformatuj,
wybrać żądany format, a następnie kliknąć OK.

W oknie dialogowym Tabela należy określić dodatkowe opcje takie jak nazwa tabeli, a
następnie kliknąć OK.

Porada – Po sformatowaniu tabeli zgodnie ze swoimi potrzebami można dodać układ do listy
stylów autoformatowania. Aby zastosować ten sam układ do innej tabeli, należy kliknąć miejsce
w innej tabeli i wybrać pozycje Tabela→Autoformatowanie.

▼ Wstawianie wierszy lub kolumn w tabelach

Kliknij dowolny wiersz lub kolumnę w tabeli.

Dodaj wiersz lub kolumnę.

■ Aby szybko wstawić wiersz pod bieżącym wierszem, należy kliknąć ikonę Wstaw wiersz na
pasku zadań Tabela.

■ Aby szybko wstawić kolumnę po prawej stronie bieżącej kolumny, należy kliknąć ikonę
Wstaw kolumnę na pasku zadań Tabela.

■ Aby określić liczbę nowych wierszy oraz ich położenie, należy wybrać pozycje
Tabela→Wstaw→Wiersze.

■ Aby określić liczbę nowych kolumn oraz ich położenie, należy wybrać pozycje
Tabela→Wstaw→Kolumny.
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Stosowanie obrazów w dokumentach tekstowych
Jest dostępnych wiele narzędzi do wstawiania obiektów i precyzyjnego określania ich wyglądu w
dokumencie tekstowym.

Aby wstawić obraz do dokumentu tekstowego, umieść kursor w miejscu, w którym obraz ma
być wstawiony, a następnie wybierz pozycje Wstaw→Obraz→Z pliku.

Włącz pole wyboru Łącze, aby wstawić obraz w postaci łącza. W ten sposób można zachować
mały rozmiar dokumentu. Jeśli dokument tekstowy ma być rozesłany do innych użytkowników
w postaci pliku, warto rozważyć osadzenie obrazów w pliku. Obrazy są osadzane, jeśli pole
wyboru Łącze nie jest włączone.

Można również osadzać obrazy wstawione jako łącza.

Po wybraniu wstawionego obrazu użytkownik ma do wyboru szereg poleceń do edycji obrazu.

■ Najczęściej używane polecenia są dostępne z menu kontekstowego. Kliknij obraz prawym
przyciskiem myszy i wybierz polecenie.
Z menu kontekstowego można wybrać podpis zawierający automatyczne numerowanie. Za
pomocą tej funkcji możliwe jest także automatyczne wygenerowanie wykazu ilustracji. Inne
polecenie w menu kontekstowym to Mapa obrazkowa. Polecenie Mapa obrazkowa służy do
utworzenia aktywnych pól, które można klikać, pełniących funkcję łączy.

Stosowanie obrazów w dokumentach tekstowych
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■ Pasek narzędzi Obraz zawiera ikony służące do zmiany przezroczystości, tworzenia efektów
dekoracyjnych i itp.
Ikon można użyć do tworzenia odbicia lustrzanego lub obrazu w skali szarości.

■ Pasek narzędzi Grafika pod paskiem Standardowy umożliwia zmianę kolorów,
obramowania itp.
Niektóre ikony zapewniają możliwość wyrównania obrazu w poziomie lub pionie w obrębie
marginesów.

■ Okno dialogowe Grafika otwiera się po dwukrotnym kliknięciu obrazu.
Zawiera ono strony kart, które umożliwiają kontrolowanie rozmiaru i położenia obrazu,
zakotwiczenia, opływania, kadrowania, wstawiania obramowania i wiele innych.
Funkcja Opływanie tekstu pozwala na sterowanie, w jaki sposób tekst opływa obraz lub
wypełnia tło. Poprzez zakotwiczenie użytkownik ma pełną kontrolę nad sposobem
zachowania się obrazu: czy obraz przesuwa się wraz z tekstem, czy jest powiązany z
akapitem bądź zachowuje położenie w stosunku do strony, bez względu na to, jak zmienia
się tekst za obrazem.
Galeria może być używana do wstawiania obrazów, obiektów clipart, animacji GIF oraz
plików dźwiękowych do dokumentu tekstowego. Patrz rozdział “Wstawianie obrazów”
na stronie 30.

Publikowanie tekstu
Rozszerzenia Wiki Publisher i Weblog Publisher pozwalają użytkownikowi na publikowanie
bieżącego dokumentu tekstowego bez większego wysiłku.

W oknie dialogowym Opcje ustawiane są właściwości dla obydwu rozszerzeń.

Za pomocą rozszerzenia bieżący dokument tekstowy można przesłać na wybrany serwer
MediaWiki. W tym celu niezbędne jest konto na serwerze. Służą do tego polecenia
Plik→Wyślij→Do MediaWiki. Obrazy w tekście nie są obecnie obsługiwane.

Rozszerzenie Weblog Publisher powoduje dodanie pewnych poleceń i ikon służących do
zapisywania dokumentów na serwerze Weblog i ładowania z serwera. Zapewnia obsługę
obrazów i tablic w tekście. W oknie dialogowym właściwości można określić serwery Weblog,
na których użytkownik ma założone konta. W pakiecie Oracle Open Office przechowywane są
w ustawieniach użytkownika różne dane uwierzytelniające z dostępem zabezpieczonym
głównym hasłem.

Publikowanie tekstu
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Oracle Open Office Calc

Oracle Open Office Calc to aplikacja typu arkusz kalkulacyjny, umożliwiająca wykonywanie
profesjonalnych obliczeń na danych i dostarczająca setek różnych formuł. Obejmuje ona
narzędzie Pilot danych (podobne do tabeli przestawnej występującej w programie Microsoft
Excel), automatyczne filtry o szerokich możliwościach i moduł Linear Solver. Zapewnia
również dostęp do zewnętrznych baz danych, wykresów 2D/3D o bogatych funkcjach,
narzędzia do wykrywania formuł, kalkulatora scenariuszy itd. Za pomocą tej aplikacji można
odczytywać, edytować, drukować i zapisywać pliki programu Microsoft Excel oraz w szybki i
łatwy sposób obliczać, analizować oraz udostępniać dane.

Podstawy pracy z arkuszami kalkulacyjnymi
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Domyślnie dokument arkusza kalkulacyjnego z pakietu Oracle Open Office zawiera trzy
arkusze z maksymalnej dozwolonej liczby 256 Arkusz1, Arkusz2 i Arkusz3. Każdy arkusz jest
podzielony na maksymalnie 1048576 wierszy oraz 1024 kolumny. Wiersze są oznaczone
liczbami, natomiast kolumny literami. Przecięcie wiersza oraz kolumny nazwy się komórką.

Komórkę określa się poprzez odniesienie składające się z liter określających kolumnę, po
których następuje liczba określająca wiersz komórki.

Odniesienie do komórki lub zakresu komórek może zawierać również nazwę pliku lub nazwę
arkusza. Aby zbudować odwołanie o prawidłowej składni, można otworzyć dwa pliki arkusza z
folderów, wprowadzić znak równości w celu rozpoczęcia tworzenia formuły, a następnie
kliknąć komórkę w drugim pliku. Zostanie wyświetlone wynikowe odwołanie. W systemie
Linux lub Solaris odwołanie będzie miało postać:
='plik:///home/nazwa_użytkownika/Dokumenty/nazwa_pliku.ods'#Arkusz1.A1.

Do komórki lub zakresu komórek można przypisać nazwę, którą można stosować zamiast
odwołania kolumna/liczba. Adresy mogą mieć formę bezwzględną lub względną.

Podstawy pracy z arkuszami kalkulacyjnymi
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Adresowanie względne
Komórka w kolumnie A i wierszu 1 ma adres A1. Zakres sąsiadujących komórek można
adresować poprzez wprowadzenie najpierw współrzędnych komórki z górnego lewego rogu
obszaru, następnie wpisanie średnika, a po nim współrzędnych komórki z dolnego prawego
rogu. Na przykład kwadrat utworzony przez pierwsze cztery komórki w górnym lewym rogu
jest adresowany w postaci A1:B2.

Poprzez tego typu adresowanie wskazywane jest odwołanie względne do obszaru A1:B2.
Względne oznacza, że odwołanie do tego obszaru będzie zmieniane automatycznie podczas
kopiowania formuł.

Adresowanie bezwzględne
Odwołanie bezwzględne stanowi przeciwieństwo adresowania względnego. W odwołaniu
bezwzględnym znak dolara jest umieszczany przed każdą literą i liczbą, na przykład $A$1:$B$2.

Bieżące odwołanie, na którym umieszczony jest kursor w wierszu wprowadzania, można
przekształcić z względnego na bezwzględne bądź odwrotnie poprzez naciśnięcie klawiszy
Shift+F4 . Jeśli na początku wprowadzony jest adres względny, np. A1, pierwsze naciśnięcie tej
kombinacji klawiszy spowoduje ustawienie odwołania bezwzględnego dla wiersza i dla
kolumny ($A$1). Przy drugim naciśnięciu odwołanie bezwzględne jest ustawiane tylko dla
wiersza (A$1), a za trzecim razem — tylko dla kolumny ($A1). Po naciśnięciu tej kombinacji
klawiszy jeszcze raz zarówno odwołania do kolumn, jak i do wierszy są przełączane z powrotem
na względne (A1).

W programie Oracle Open Office Calc są pokazywane odwołania do formuły. Jeśli na przykład
użytkownik kliknie w komórce formułę =SUM(A1:C5;D15:D24), obydwa obszary, do których
występuje odwołanie, będą podświetlone na kolorowo. Gdy komponent formuły “A1:C5”
będzie na przykład wyświetlany w kolorze niebieskim, wówczas zakres komórek, o którym
mowa, zostanie otoczony obramowaniem w tym samym odcieniu koloru niebieskiego. Kolejny
komponent formuły “D15:D24” zostanie w podobny sposób oznaczony na czerwono.

Kiedy używać odwołań względnych i bezwzględnych
Co wyróżnia odwołanie względne? Załóżmy, że w komórce E1 chcemy obliczyć sumę komórek
z zakresu A1:B2. Do komórki E1 zostanie wprowadzona formuła: =SUM(A1:B2). Jeśli później
zdecydujemy się na wstawienie nowej kolumny przed kolumną A, elementy, które zechcemy
dodać, będą się znajdowały w zakresie B1:C2, a sama formuła w komórce F1, a nie w E1. Po
wstawieniu nowej kolumny należy zatem sprawdzić i poprawić wszystkie formuły w arkuszu
oraz być może w innych arkuszach.

Na szczęście tę czynność wykonuje za użytkownika program Oracle Open Office Calc. Po
wstawieniu nowej kolumny A formuła =SUM(A1:B2) zostanie automatycznie uaktualniona na
=SUM(B1:C2). Numery wierszy będą również automatycznie modyfikowane po wstawieniu
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wiersza 1. W programie Oracle Open Office Calc za każdym razem, gdy obszar, do którego
występują odwołania, jest przesuwany, odwołania bezwzględne i względne zawsze ulegają
modyfikacji. Należy jednak zachować ostrożność podczas kopiowania formuły, ponieważ tylko
względne odwołania są modyfikowane, a bezwzględne nie.

Odwołania bezwzględne są używane, gdy obliczenia odnoszą się do konkretnej komórki w
arkuszu. Jeśli formuła, która odnosi się do dokładnie tej komórki, jest kopiowana w trybie
względnym do komórki poniżej pierwotnej komórki, odwołanie zostanie również przesunięte,
o ile współrzędne komórki nie zostaną zdefiniowane jako bezwzględne.

Oprócz sytuacji, w których są wstawiane nowe wiersze i kolumny, odwołania mogą się zmieniać
również w przypadku, gdy istniejąca formuła z odwołaniami do konkretnych komórek zostanie
skopiowana do innego obszaru arkusza. Załóżmy, że w wierszu 10 wprowadzono formułę
=SUM(A1:A9). Jeśli ma być obliczona suma w kolumnie sąsiadującej z prawej strony, wystarczy
przekopiować tę formułę do komórki po prawo. Kopia formuły w kolumnie B zostanie
automatycznie zmodyfikowana na =SUM(B1:B9).

Poruszanie się po arkuszu
W celu poruszania się po arkuszu w programie Calc lub zaznaczania elementów w arkuszu,
można użyć myszki lub klawiatury. Aby szybko przejść do komórki, której nie ma na ekranie,
należy wprowadzić jej adres w polu Obszar arkusza z lewej strony paska formuły.

Zaznaczanie komórek w arkuszu
Do zaznaczenia komórek w arkuszu programu Calc można użyć myszy lub klawiatury:

■ Aby zaznaczyć zakres komórek myszką, należy kliknąć komórkę i przeciągnąć kursorem do
kolejnej komórki.

■ Aby zaznaczyć tylko jedną komórkę, należy nacisnąć klawisz Shift oraz kliknąć komórkę.
■ Aby zaznaczyć cały wiersz lub kolumnę, należy kliknąć etykietę wiersza lub kolumny.
■ Aby zaznaczyć wszystkie komórki, należy kliknąć przycisk znajdujący się nad wierszem 1 i

na lewo od kolumny A.
■ Aby zaznaczyć zakres komórek za pomocą klawiatury, należy przytrzymać klawisz Shift i

nacisnąć klawisz strzałki, pamiętając o tym, aby kursor znajdował się w komórce.

Ewentualnie można wprowadzić zakres w polu Obszar arkusza.

Podstawy pracy z arkuszami kalkulacyjnymi
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Wprowadzanie danych do arkusza kalkulacyjnego
■ Kliknij komórkę, w której chcesz wprowadzić dane.
■ Wpisz lub wklej dane ze schowka do komórki wybierając Edycja→Wklej.
■ Wprowadź dane.
■ Naciśnij klawisz Enter.

Możesz również nacisnąć strzałkę, aby wprowadzić dane i przejść do kolejnej komórki w
kierunku strzałki.

Porada – Aby wpisać tekst w więcej niż jednym wierszu w komórce, naciśnij klawisze
Control+Enter na końcu każdego wiersza, a po zakończeniu naciśnij klawisz Enter.

▼ Szybkie wprowadzanie kolejnych dat i numerów
Program Oracle Open Office Calc obejmuje funkcję uzupełniania umożliwiającą wprowadzanie
kolejnych serii danych, takich jak daty, dni, miesiące oraz liczby. Zawartość każdej kolejnej
komórki w serii wzrasta o jeden. 1 jest zwiększane do 2, poniedziałek jest zwiększany do
wtorku itd.

Kliknij na komórce.

Wpisz pierwszy element z serii (na przykład poniedziałek i naciśnij klawisz Enter.

Kliknij na komórce i przeciągnij uchwyt wypełniania do momentu podświetlenia zakresu
komórek, do których chcesz wprowadzić serię danych.

Uchwyt wypełniania to mały czarny kwadracik w dolnym prawym rogu komórki.

Zwolnij przycisk myszy.

Kolejne elementy z serii są dodawane automatycznie do podświetlonych komórek.

1
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Porada – Korzystając z opcji Narzędzia→Opcje→Oracle Open Office Calc→Listy sortowania,
można przeglądać zdefiniowane serie oraz zdefiniować własne.

Aby skopiować dane bez zmieniania wartości serii, podczas przeciągania naciśnij klawisz Ctrl.

Edycja zawartości komórek
Zawartość komórek lub zakresów komórek w arkuszu kalkulacyjnym można edytować.

▼ Edycja zawartości komórek w arkuszu

Kliknij na komórce lub zaznacz zakres komórek.

Aby edytować zawartość pojedynczej komórki, należy dwukrotnie kliknąć komórkę oraz
wprowadzić żądane zmiany.

Porada – Można również kliknąć na komórce, wprowadzić zmiany w wierszu wprowadzania
danych na pasku formuł, a następnie kliknąć ikonę z zielonym znaczkiem zaznaczenia. W razie
konieczności wprowadzenia tekstu składającego się z wielu linijek o określonych odstępach,
należy dwukrotnie kliknąć komórkę i edytować zawartość wewnątrz komórki. Naciśnij klawisze
Control+Enter, aby wprowadzić odstęp. W wierszu wprowadzania danych, nie można
wprowadzać odstępów.

Program Calc przekształca wprowadzane dane w najbardziej odpowiedni sposób. Jeżeli
wprowadzane dane mają charakter liczbowy, program Calc formatuje je jako liczby. Podobnie
dzieje się w przypadku dat oraz czasu. Aby uniknąć automatycznego przekształcania danych na
liczby lub daty, przed wprowadzaną liczbą należy umieścić pojedynczy cudzysłów (').

Naciśnij klawisz Enter.

Aby usunąć zawartość komórki lub zakresu komórek, należy nacisnąć klawisz BackSpace lub
Delete.
Po naciśnięciu klawisza BackSpace zawartość jest usuwana natychmiastowo, natomiast po
naciśnięciu klawisza Delete wyświetlone zostanie okno dialogowe.
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Formatowanie arkuszy kalkulacyjnych
Arkusze kalkulacyjne można formatować ręcznie lub za pomocą stylów. Formatowanie ręczne
zostaje zastosowane wyłącznie do zaznaczonych komórek. Formatowanie za pomocą stylów
zostaje zastosowane w miejscach w arkuszu kalkulacyjnym, w których używane są style.

Formatowanie komórek za pomocą funkcji
Autoformatowanie
Program Oracle Open Office Calc zawiera funkcję Autoformatowanie, dzięki której jednolite
sformatowanie zakresu komórek można uzyskać po kilku kliknięciach.

▼ Stosowanie automatycznego formatowania dla zakresu komórek

Wybierz zakres komórek, które mają zostać sformatowane.
Wybierz minimalny zakres komórek 3×3.

Wybierz Format→Autoformatowanie.
Wyświetlone zostanie okno dialogowe Autoformatowanie.

Z listy formatów, wybierz żądany format, a następnie kliknij OK.

Uwaga – Można również określić własny format komórek i dodać go do listy stylów
autoformatowania.

Ręczne formatowanie komórek
Aby zastosować proste formatowanie do zawartości komórki np. zmianę rozmiaru czcionki,
należy użyć ikon z paska narzędzi Formatowanie.

Aby sformatować komórki za pomocą paska narzędzi Formatowanie, wybierz komórkę lub
zakres komórek do sformatowania.

Na pasku narzędzi Formatowanie kliknij ikonę odpowiadającą poleceniu formatowania, które
chcesz zastosować lub wybierz opcję z listy rozwijanej Czcionki lub Rozmiar czcionki.

1

2

3

Formatowanie arkuszy kalkulacyjnych

Rozdział 5 • Oracle Open Office Calc 61



▼ Ręczne formatowanie za pomocą okna dialogowego formatowania
komórek
Aby uzyskać dostęp do większej liczby opcji formatowania niż oferuje pasek narzędzi
Formatowanie, należy skorzystać z okna dialogowego Formatowanie komórek.

Wybierz komórkę lub zakres komórek, które mają zostać sformatowane, a następnie wybierz
Format→Komórki.

Wyświetlone zostanie okno dialogowe Formatowanie komórek.

Wybierz jedną z zakładek i określ opcje formatowania.
Zakładka Liczby Wyświetla opcje formatowania liczb w komórkach np. zmiana

wyświetlanej liczby miejsc dziesiętnych

Zakładka Czcionki Wyświetla opcje zmiany czcionki, rozmiaru czcionki oraz kroju
czcionki w danej komórce

Zakładka Efekty czcionki Wyświetla opcje zmiany koloru czcionki oraz efektów
podkreślenia, przekreślenia lub wypukłości tekstu

Zakładka Wyrównanie Wyświetla opcje zmiany wyrównania oraz położenia tekstu w
komórkach

Zakładka Krawędzie Wyświetla opcje zmiany obramowania komórek

Zakładka Tło Wyświetla opcje zmiany tła wypełnienia komórek

Zakładka Ochrona
komórek

Wyświetla opcje ochrony zawartości komórek wewnątrz
chronionych arkuszy

Kliknij OK.

Formatowanie komórek i arkuszy za pomocą stylów
Styl jest zbiorem opcji formatowania, który określa wygląd zawartości komórek oraz układ
arkusza. Przy zmianie formatowania stylu, zmiany zostają zastosowane do wszystkich miejsc w
arkuszu, w których używany jest dany styl.

Aby zastosować formatowanie za pomocą okna Style i formatowanie, wybierz pozycje
Format→Style i formatowanie.

Aby zmienić formatowanie komórek, kliknij komórkę lub zaznacz zakres komórek. Kliknij
ikonę Style komórki w górnym obszarze okna Style i formatowanie. Dwukrotnie kliknij styl na
liście.
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Aby zmienić układ arkusza, kliknij jego dowolną część. Kliknij ikonę Style strony w górnym
obszarze okna Style i formatowanie. Dwukrotnie kliknij styl na liście.

Korzystanie z formuł oraz funkcji
Do przeprowadzenia prostych lub złożonych obliczeń można użyć formuł w arkuszu
kalkulacyjnym.

Jeżeli formuła zawiera odwołania do komórek, wynik jest aktualizowany automatycznie wraz ze
zmianą zawartości komórek. Program Oracle Open Office Calc dostarcza wielu funkcji, za
pomocą których można zaprojektować formuły do wykonywania obliczeń.

Tworzenie formuł
Formuła zaczyna się od znaku równości (=) i może zawierać wartości, odniesienia do komórek,
operatory, funkcje oraz stałe.

▼ Tworzenie formuł

Kliknij komórkę, w której chcesz wyświetlić wynik formuły.

Wpisz =, a następnie wpisz formułę.
Na przykład aby dodać zawartość komórki A1 do zawartości komórki A2, wpisz wzór =A1+A2 w
innej komórce.

Porada – Wpis można również rozpocząć od klawiszy + lub - na klawiaturze numerycznej.

Naciśnij klawisz Enter.

Używanie operatorów
W formułach można stosować następujące operatory.

TABELA 5–1 Operatory w formułach w programie Calc

Operator Nazwa Przykład Wynik

+ Dodawanie =1+1 2

- Odejmowanie =2–1 1
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TABELA 5–1 Operatory w formułach w programie Calc (Ciąg dalszy)
Operator Nazwa Przykład Wynik

* Mnożenie =7*9 63

/ Dzielenie =10/2 5

% Procent =15% 15,00%

^ Potęga =3^2 9

= Równość =8=8 PRAWDA

> Większe niż =7>9 FAŁSZ

< Mniejsze niż =5<6 PRAWDA

>= Większe lub równe =3>=4 FAŁSZ

<= Mniejsze lub równe =42<=63 PRAWDA

<> Nierówność =6<>4 PRAWDA

& Łączenie tekstu =“Nie” & “dziela” Niedziela

PRZYKŁAD 5–1 Przykłady formuł w programie Calc

=A1+15 Wyświetla wynik dodawania 15 oraz zawartości komórki A1

=A1*20% Wyświetla 20 procent zawartości komórki A1

=A1*A2 Wyświetla wynik mnożenia zawartości komórek A1 oraz A2

Użycie cudzysłowów
Podczas wykonywania obliczeń w programie Calc przestrzegana jest kolejność działań.
Mnożenie i dzielenie jest wykonywane przed dodawaniem i odejmowaniem, niezależnie od
miejsca występowania operatorów w formule. Na przykład jako wynik formuły =2+5+5*2
program Calc zwraca wartość 17. Wprowadzenie formuły =(2+5+5)*2 daje wartość 24.

Kolejność operacji można zmieniać poprzez użycie nawiasów, które mają pierwszeństwo przed
operatorami.

Edycja formuł
Komórka zawierająca formułę wyświetla jedynie wynik formuły. Formuła jest wyświetlana w
wierszu wprowadzania danych.

Korzystanie z formuł oraz funkcji
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▼ Edycja formuł

Kliknij komórkę zawierająca formułę.
Ewentualnie, można również dwukrotnie kliknąć komórkę w celu bezpośredniej edycji
zawartości.

Formuła jest wyświetlana w wierszu wprowadzania danych na pasku Formuła.

Kliknij na wierszu wprowadzania danych i dokonaj zmian.
Aby usunąć część formuły, naciśnij klawisz Delete lub BackSpace.

Naciśnij klawisz Enter lub kliknij na pasku Wzór, aby zaakceptować zmiany.
Aby odrzucić wprowadzone zmiany, naciśnij klawisz Esc lub kliknij na pasku Wzór.

Użycie funkcji
W programie Calc jest dostępnych wiele gotowych funkcji. Na przykład, zamiast wpisywać
=A2+A3+A4+A5, można po prostu wpisać =SUMA(A2:A5). Kreator funkcji ułatwia wpisywanie
formuł oraz funkcji.
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▼ Wprowadzanie funkcji
Kliknij komórkę, w której chcesz wprowadzić funkcję.

Wybierz Wstaw→Funkcja.
Wyświetlone zostanie okno dialogowe Kreatora funkcji.

W polu Kategoria, wybierz kategorię zawierającą typ funkcji, której chcesz użyć.

Z listy funkcji, wybierz funkcję, której chcesz użyć.

Kliknij Dalej.

Wprowadź żądane wartości lub kliknij komórki na arkuszu kalkulacyjnym zawierające wartości,
których chcesz użyć.

Kliknij OK.
Kreator funkcji ułatwia tworzenie i wizualizację funkcji zagnieżdżonych.

Porada – Więcej informacji na temat korzystania z funkcji w programie Calc można odnaleźć w
pliku pomocy programu Calc.
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Zaawansowane funkcje arkusza kalkulacyjnego
Menu Calc zawiera wiele zaawansowanych funkcji pomocnych w zarządzaniu danymi i ich
wizualizacji. Wśród tych funkcji znajdują się: Pilot danych, scenariusze i moduł Solver, których
można użyć do wykonywania bardziej złożonych zadań zarządzania danymi.

Pilot danych
Pilot danych (znany również pod nazwą tabeli przestawnej) umożliwia łączenie, porównywanie
i analizowanie dużych ilości danych. Dzięki niemu możliwe jest wyświetlanie różnych
podsumowań danych źródłowych i szczegółowych informacji na temat interesujących
obszarów oraz tworzenie raportów. Tabele tworzone za pomocą funkcji Pilot danych są
tabelami interaktywnymi. Dane można porządkować na wiele sposobów i zestawiać według
różnych punktów widzenia.

Scenariusze
Scenariusz programu Oracle Open Office Calc to zestaw wartości komórek, których można
użyć w obliczeniach. Do każdego scenariusza w arkuszu przypisywana jest nazwa. W tym
samym arkuszu można utworzyć kilka scenariuszy — każdy z innymi wartościami w
komórkach. Wywołanie nazwy scenariusza pozwala na łatwe przełączanie między zestawami
wartości i szybkie zaobserwowanie zmieniających się wyników. Scenariusze to narzędzie
służące do testowania pytań “co-jeśli”.

Zaawansowane funkcje arkusza kalkulacyjnego
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Solver
Moduł Solver umożliwia rozwiązywanie równań z wieloma niewiadomymi z użyciem metod
szukania rozwiązania. Zadaniem modułu Solver jest znalezienie takich wartości zmiennych
równania, które prowadzą do otrzymania wartości zoptymalizowanej (czyli znalezienia
szukanego rozwiązania). Można określić, czy wartość w komórce docelowej ma być wartością
maksymalną, minimalną, czy też zbliżoną do wartości podanej.

Istnieje możliwość zdefiniowania serii warunków w celu podania ograniczeń dotyczących
wybranych komórek. Można na przykład nałożyć warunek mówiący, aby jedna ze zmiennych
lub wartości komórki nie była większa od innej zmiennej lub od podanej wartości. Możliwe jest
także zdefiniowanie warunku, aby co najmniej jedna ze zmiennych była liczbą całkowitą (tj.
liczbą bez miejsc dziesiętnych) lub wartością binarną (czyli taką, która może zawierać jedynie
cyfry 0 i 1).

Zaawansowane funkcje arkusza kalkulacyjnego
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Korzystanie z wykresów
Wykresy pomagają w wizualizacji wzorców i trendów w danych liczbowych. Pakiet Oracle
Open Office 3 oferuje kilka stylów wykresów, których można użyć do wizualizacji wartości
liczbowych.

Wykres można utworzyć na podstawie danych numerycznych zawartych w komórkach tabeli w
programie Calc lub Writer. Wraz ze zmianą wartości w komórkach, automatycznie zmieni się
wykres.

Korzystanie z wykresów
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Uwaga – Wstawianie wykresów nie jest ograniczone do arkuszy. Wykresy można wstawiać
również w innych programach pakietu Oracle Open Office, wybierając opcję
Wstaw→Obiekt→Wykres. Wstawiane wykresy są oparte a standardowych danych, które
następnie można zamienić własnymi danymi.

▼ Tworzenie wykresów
Wybierz komórki, w tym nagłówki, zawierające dane do wykresu.
Aby wybrać sąsiadujący obszar danych, wystarczy tylko kliknąć dany obszar. Ręczne
zaznaczenie nie jest konieczne.

W przypadku niesąsiadujących obszarów danych zaznacz co najmniej jedną komórkę.
Następnie trzymając wciśnięty klawisz Ctrl, kliknij każdą z dodatkowych komórek.
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Wybierz Wstaw→Wykres.
Wyświetlony zostanie Kreator wykresów wraz z rzeczywistym podglądem wykresu z bieżącymi
ustawieniami.

Wybierz typ wykresu i postępuj według instrukcji Kreatora wykresów.

Kliknij przycisk Koniec.

Edycja wykresów
Po utworzeniu wykresu, można zmieniać, przenosić, zmieniać rozmiar lub usuwać wykresy.

Wykres może się znajdować w jednym z trzech trybów: trybie normalnym, obiektowym lub
trybie edycji.

■ W trybie normalnym wykres jest wyświetlany podobnie jak inne obiekty w dokumencie lub
arkuszu.

■ Kliknij jednokrotnie wykres w trybie normalnym, aby przejść do trybu obiektowego.
W trybie obiektowym na obramowaniu wykresu widocznych jest osiem uchwytów, dzięki
którym można wykres przesuwać, zmieniać jego rozmiar lub go usunąć. Więcej poleceń jest
dostępnych w trybie obiektowym po otwarciu menu kontekstowego.
Kliknij poza wykresem, aby porzucić tryb obiektowy i powrócić do trybu normalnego.

■ Kliknij wykres dwukrotnie, aby uruchomić tryb edycji.
W trybie edycji kliknięcie elementów tworzących wykres umożliwia edycję ich właściwości.
Narzędzia do edycji wykresu zawierają polecenia menu i paski narzędzi.
Kliknij poza wykresem, aby porzucić tryb edycji i powrócić do trybu normalnego.

▼ Zmiana rozmiaru, przeniesienie lub usunięcie wykresu

Zaznacz wykres.
Jeśli wykres nie jest zaznaczony, kliknij go jednokrotnie. Wokół wykresu zostamie wyświetlone
osiem dużych uchwytów. Jeżeli wykres jest w trybie edycji, należy najpierw kliknąć obszar poza
wykresem, a następnie kliknąć wykres.

Zmień rozmiar, przenieś lub usuń wykres

■ Aby zmienić rozmiar wykresu, należy przesunąć kursor myszy nad jeden z dużych uchwytów,
przytrzymać przycisk myszy i przeciągnąć myszą.
W programie Calc wyświetlany jest zarys w postaci kropkowanej linii nowego wykresu
podczas przeciągania.
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■ Aby przenieść wykres, należy przesunąć kursor myszy na środku wykresu, przytrzymać
przycisk myszy i przeciągnąć wykres w nowe miejsce.

■ Aby usunąć wykres, naciśnij klawisz Delete.

▼ Zmiana wyglądu wykresu
Aby zmienić właściwości wykresu, można użyć menu kontekstowego wykresu.

Dwukrotnie kliknij wykres, aby przełączyć go do trybu edycji.

Prawym przyciskiem myszy kliknij dowolny element wykresu.
Wyświetlone zostanie menu kontekstowe.

Wybierz odpowiednie polecenie, aby zmienić element.

Kliknij poza wykresem, aby porzucić tryb edycji.
Zmiany wprowadzone do wykresu są zapamiętywane podczas zapisywania dokumentu, w
którym wykres jest osadzony.
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Oracle Open Office Impress

Program Oracle Open Office Impress to narzędzie prezentacji udostępniające intuicyjny
interfejs do tworzenia i edytowania prezentacji oraz dostarczające dziesiątek animacji na
slajdach, animacji niestandardowych oraz łatwych w użyciu tabel. Użytkownik ma także do
dyspozycji obsługę autokształtów, możliwość wpisywania komentarzy i uwag oraz korzystania
z funkcjonalności wzorców i konsoli osoby prezentującej (podobnej do widoku prezentera z
programu Microsoft PowerPoint). Dzięki temu narzędziu można odczytywać, edytować,
drukować i zapisywać pliki programu Microsoft PowerPoint.

Tworzenie prezentacji
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Aby utworzyć prezentację w dowolnym programie pakietu Oracle Open Office, wybierz opcję
Plik→Nowy→Prezentacja.

To polecenie powoduje otwarcie kreatora prezentacji. Użytkownik, który nie chce korzystać z
tej funkcji, może ją wyłączyć na pierwszej stronie. Aby ponownie włączyć kreator, otwórz
prezentację, wybierz pozycje Narzędzia→Opcje→Oracle Open Office →Impress→Ogólne i
uaktywnij opcję Rozpoczynaj pracę z kreatorem. (W systemie Mac OS X okno opcji otwierane
jest poprzez wywołanie pozycji menu Oracle Open Office→Preferencje).

Aby zapisać prezentację, wybierz pozycje Plik→Zapisz.

Jeżeli prezentacja nie została zapisana wcześniej, wyświetlone zostanie okno dialogowe Zapisz
jako. W polu Nazwa pliku, wpisz nazwę prezentacji. Kliknij polecenie Zapisz.

Tworzenie prezentacji
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Minimalizator prezentacji umożliwia zapisywanie prezentacji w formacie pliku ODP do
rozesłania innym osobom. Wielkość obrazów jest zmniejszana, a nieużywane elementy zostają
usunięte z pliku. Aby otworzyć narzędzie Minimalizator prezentacji, wybierz pozycje
Narzędzia→Minimalizuj prezentację.

Prezentację można zapisać jako szereg połączonych stron HTML, plik PDF lub plik Flash.

Aby eksportować prezentację do innego formatu, wybierz pozycje Plik→Eksportuj. W polu
Nazwa pliku, wpisz nazwę prezentacji. W polu Typ pliku, wybierz format eksportowanego
pliku. Kliknij Eksportuj.

Edycja slajdów
Układ slajdów oraz format tekstu można zmienić. Możliwe jest także dodawanie tabel,
wykresów i grafiki do slajdów oraz stosowanie różnorodnych kolorów.

Aby ułatwić edycję oraz organizację slajdów w programie Impress, można użyć różnych
widoków obszaru roboczego. W trybie widoku normalnego można dodawać obrazy do
pojedynczych slajdów. Za pomocą funkcji sortowania slajdów można zmieniać kolejność
slajdów oraz przypisywać im różne efekty przejścia. W trybie Wzorzec można organizować oraz
edytować tytuły slajdów.

Edycja slajdów
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Aby zmienić widok, należy kliknąć zakładkę Widok w środkowym panelu.

Aby przejść pomiędzy slajdami w trybie widoku normalnego, należy kliknąć podgląd slajdu w
lewym panelu slajdów.

Aby zmienić układ slajdu w widoku normalnym, wybierz slajd, w którym ma być zastosowany
nowy układ. W panelu Zadania, należy wybrać układ, który ma zostać użyty.

Aby wstawić slajd, kliknij kartę Normalny, aby wybrać widok normalny. Na panelu Slajdy po
lewej stronie należy kliknąć prawym przyciskiem myszy w miejscu, w którym ma zostać dodany
slajd. Z menu kontekstowego należy wybrać polecenie Nowy slajd.

Aby skopiować slajd w widoku normalnym, wybierz slajd do kopiowania. Wybierz
Wstaw→Duplikuj slajd.

Aby przesunąć slajd w widoku Sortowanie slajdów, przeciągnij slajd w inne położenie.

Aby usunąć slajd, zaznacz slajd i wybierz pozycje Edycja→Usuń slajd.

Formatowanie tekstu slajdu
Aby szybko zmienić formatowanie tekstu na slajdzie, należy użyć paska narzędzi Formatowanie
tekstu. W tym celu, należy zaznaczyć tekst, który ma zostać sformatowany i kliknąć
odpowiednią ikonę. Można również wybrać żądaną opcję z listy rozwijanej Nazwa czcionki lub
Rozmiar czcionki.

Edycja slajdów
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Dodawanie obrazów do slajdów
Dzięki obrazom slajdy mogą wyglądać w bardzie interesujący sposób. Program Impress
umożliwia dodawanie do slajdów grafik np. zdjęć lub obrazów. Użytkownik może użyć grafik
dostarczanych w pakiecie Oracle Open Office lub wstawić własne grafiki.

▼ Dodawanie obrazu z pliku

Wybierz Wstaw→Obraz→Z pliku.
Wyświetlone zostanie okno dialogowe Wstaw obraz.

Znajdź grafikę, którą chcesz wstawić, a następnie kliknij Otwórz.

Tekst graficzny utworzony z wykorzystaniem funkcji
Fontwork
Za pomocą funkcji Fontwork można wstawiać tekst graficzny o różnych kształtach i
schematach kolorystycznych.

▼ Dodawanie tekstu Fontwork

Na pasku narzędzi Rysowanie, kliknij ikonę Galeria Fontwork.
Wyświetlone zostanie okno Fontwork.
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Dwukrotnie kliknij obiekt Fontwork.

Okno Fontwork zostanie zamknięte, a wybrany obiekt graficzny pojawi się w bieżącym
dokumencie.

Dwukrotnie kliknij obiekt graficzny.

Test “Fontwork” jest wyświetlany jako normalny podświetlony tekst wyśrodkowany na obrazie.

Usuń standardowy tekst i wpisz własny tekst. Naciśnij klawisz Esc lub kliknij poza obszarem
grafiki, aby zakończyć wprowadzanie tekstu.

Właściwości grafiki można edytować. Wybierz Widok→Paski narzędzi→Linia i wypełnienie,
aby wyświetlić pasek narzędzi Obramowanie i wypełnienie. Zmień kolory obszaru oraz
obramowania, szerokość oraz styl obramowań lub przekształć grafiki do trybu
trójwymiarowego za pomocą menu kontekstowego.

Tworzenie efektów przejścia slajdów
Dla prezentacji na ekranie, można zastosować efekty przejść z jednego slajdu do drugiego w
postaci np. żaluzji lub zakrywania.

▼ Dodawanie efektów przejścia do slajdów

Uwaga – Efekty przejścia są uruchamiane wraz ze zmianą slajdu. Aby zastosować przejście
pomiędzy slajdem 1 i 2, należy przypisać przejście do slajdu 2.

Wybierz widok Sortowanie slajdów lub włącz panel Slajdy po lewej stronie.

Prawym przyciskiem myszy kliknij slajd, a następnie z menu kontekstowego wybierz polecenie
Przejście slajdów.

W panelu Zadania otworzy się okno Przejście slajdu.

Kliknij efekt przejścia.
Podgląd efektu jest wyświetlany automatycznie na slajdzie.

Dodawanie efektów animacji do tekstu oraz grafik
Aby wyświetlić tekst lub grafiki po kliknięciu myszką, można użyć efektów animacji.
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▼ Dodawanie efektów animacji do tekstu oraz grafiki

W trybie widoku normalnego, należy wybrać slajd zawierający tekst lub grafikę, które mają być
animowane.

Wybierz obiekt tekstowy lub grafikę, które mają zostać zmodyfikowane.

Wybierz Pokaz slajdów→Animacja niestandardowa.
W panelu Zadania otworzy się strona Animacja niestandardowa.

Kliknij Dodaj.

W oknie dialogowym Animacja niestandardowa→Dodaj, należy wybrać żądany efekt, a
następnie kliknąć OK.
Kliknij przycisk Opcje efektów, aby zmienić właściwości czasu np. dla pojawiających się kolejno
akapitów z tekstem.

Uwaga – Użytkownik może dodać dowolną liczbę efektów. Więcej informacji na temat strony
Animacja niestandardowa można uzyskać w opcji pomocy aplikacji Impress.

Odtwarzanie pokazu slajdów
Po utworzeniu pokazu slajdów można go odtworzyć przed publicznością.

▼ Prezentacja pokazu slajdów
Otwórz prezentację, którą chcesz wyświetlić jako pokaz slajdów.

Naciśnij klawisz F5 lub wybierz polecenie Pokaz slajdów z menu pokaz slajdów.

Przeglądaj kolejno slajdy.

■ Aby przejść do kolejnego slajdu, naciśnij klawisz spacji, Enter lub Page Down albo kliknij
lewym przyciskiem myszy.

■ Aby przejść do następnego slajdu bez odtwarzania efektów, naciśnij kombinację klawiszy
Alt+Page Down.

■ Aby przejść do poprzedniego slajdu, naciśnij klawisz strzałki w lewo lub Page Up bądź kliknij
prawy przycisk myszy.
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■ Aby przejść do poprzedniego slajdu bez odtwarzania efektów, naciśnij kombinację klawiszy
Alt+Page Up.

■ Aby przejść do konkretnego slajdu, wpisz jego numer i naciśnij klawisz Enter.

Pomoc programu Impress zawiera listę wszelkich dostępnych klawiszy, które mogą okazać się
przydatne podczas prezentacji slajdów.

Mając do dyspozycji dwa niezależne monitory, można użyć funkcji Konsola osoby
prezentującej. Pozwala ona, na przykład, na wyświetlanie prezentacji z użyciem projektora, a
jednocześnie oglądanie na ekranie laptopa następnego slajdu, notatek prelegenta i innych
informacji.

Włącz funkcję Konsola osoby prezentującej i wybierz ekrany do wyświetlania za pomocą
polecenia menu Pokaz slajdów→Ustawienia pokazu slajdów.

▼ Zakończenie pokazu slajdów
Naciśnij klawisz Esc.●

Odtwarzanie pokazu slajdów
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Oracle Open Office Draw

Oracle Open Office Draw to aplikacja grafiki wektorowej dostarczająca dziesiątki kształtów i
łączników do wykorzystania podczas tworzenia schematów blokowych, wykresów, rozkładów
pomieszczeń, schematów struktury organizacji i wielu innych obiektów graficznych. Aplikacja
pomaga uatrakcyjnić przekazywanie informacji przez łatwe tworzenie rysunków, szkiców itd.

Tworzenie rysunku
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Aby utworzyć rysunek w dowolnym programie pakietu Oracle Open Office, wybierz opcję
Plik→Nowy→Rysunek.

Rysowanie podstawowych kształtów
Narzędzia programu Draw umożliwiają tworzenie i modyfikację swobodnych oraz
precyzyjnych linii, a także dwu- i trójwymiarowych kształtów. Narzędzia te są dostępne na
pasku narzędzi Rysunek.

Porada – Można używać wszystkich narzędzi na pasku na dwa sposoby: pojedyncze kliknięcie
ikony powoduje jednokrotne wykonanie odpowiedniej operacji. Na przykład narysowanie
jednego kształtu. Po ukończeniu operacji obraz kursora zostaje zmieniony na normalny kursor
wskazujący. Dwukrotne kliknięcie ikony umożliwia wielokrotne wykonywanie tej samej
operacji do momentu kliknięcia innej ikony lub naciśnięcia klawisza Escape.

Rysowanie podstawowych kształtów
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Rysowanie kształtów trójwymiarowych
Program umożliwia tworzenie trójwymiarowych obiektów (3D) poprzez przekształcenie
dwuwymiarowych obiektów (2D).

▼ Przekształcanie obiektów dwuwymiarowych 2D na obiekty
trójwymiarowe 3D

Wybierz obiekt 2D na rysunku.

Prawym przyciskiem myszy kliknij obiekt, z menu kontekstowego wybierz polecenie
Konwertuj, a następnie wybierz Na 3D lub Na obiekt obrotowy 3D.

Wstawianie tekstu do rysunku
Ikona Tekst na pasku narzędzi Rysunek umożliwia dodawanie tekstu do rysunku.

▼ Wstawianie tekstu do rysunku
Na pasku narzędzi Rysunek, kliknij ikonę Tekst.
Wyświetlony zostanie pasek narzędzi Formatowanie tekstu.

W dokumencie, należy przeciągnąć kursorem, aby utworzyć prostokąt w miejscu wprowadzania
tekstu.

Następnie należy wprowadzić tekst.

Aby sformatować tekst, należy zaznaczyć tekst, a następnie kliknąć jedną z ikon na pasku
narzędzi Formatowanie tekstu.

Porada – Aby dodać tekst do istniejącego prostokąta lub elipsy, należy dwukrotnie kliknąć
obiekt, a następnie wprowadzić tekst.
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Wstawianie tekstu do rysunku
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Edycja rysunku
Program umożliwia modyfikowanie lub usuwanie obiektów oraz formatowanie tekstu na
rysunkach.

Korzystanie z paska narzędzi linia i wypełnienie
Pasek narzędzi Linia i wypełnienie umożliwia szybką zmianę wyglądu obiektów na rysunku.
Aby użyć paska narzędzi, należy wybrać obiekt, który ma zostać zmodyfikowany i kliknąć ikonę
na pasku narzędzi lub wybrać opcję z jednego z pól na pasku narzędzi.

Porada – Aby zmienić kolor domyślny, styl linii i inne opcje dostępne na pasku Linia i
wypełnienie, upewnij się, że nie wybrano żadnego elementu w dokumencie, a następnie zmień
wybrane ustawienie.

▼ Wyrównanie obiektów na rysunku
Podczas tworzenia nowych obiektów na stronie rysunku dostępnych jest wiele narzędzi do
wyrównania obiektów. Obiekty można wyrównać względem innych obiektów lub marginesów
strony. W oknie dialogowym możliwe jest określenie stałego położenia i rozmiaru obiektów.
Obiekty można również przesuwać i zmieniać ich skalę za pomocą myszy lub klawiszy strzałek.

Precyzyjne dobranie rozmiaru obiektów i umieszczenie ich w określonych punktach strony
umożliwia siatka “przyciągająca” obiekty. Wybierz pozycję Widok→Paski narzędzi→Opcje,
aby wyświetlić pasek narzędzi Opcje, na którym znajduje się wiele ikon umożliwiających
korzystanie z siatki. Aby ustawić właściwości siatki, wybierz pozycję
Narzędzia→Opcje→Oracle Open Office Impress/Draw→Siatka.

Edycja rysunku
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Na pasku narzędzi Rysunek kliknij ikonę Wyrównanie ze strzałką w prawo.
Wyświetlony zostanie pasek narzędzi Wyrównanie. Pasek tytułu można przeciągnąć, aby pasek
narzędzi pozostał otwarty lub wystarczy kliknąć ikonę na pasku zadań.

Przeciągnij kursorem po rysunku, aby zaznaczyć obiekty, które mają zostać wyrównane.

Uwaga – Możesz również wybrać obiekt, a następnie przytrzymać klawisz Shift, jednocześnie
wybierając pozostałe obiekty.

Na pasku narzędzi Wyrównanie, kliknij odpowiednią ikonę, aby wybrać żądany rodzaj
formatowania.

▼ Organizacja obiektów na rysunku
Obiekty dodawane do rysunku są umieszczane kolejno jeden nad drugim. Obiekt utworzony
jako ostatni znajdzie się na wierzchu. Efekt ten jest widoczny w przypadku zachodzenia na
siebie obiektów. Aby zmienić kolejność obiektów, można użyć funkcji Rozmieszczenie w
programie Draw.

Na pasku narzędzi Rysunek, kliknij strzałkę ikony Rozmieść.
Wyświetlony zostanie pasek narzędzi Rozmieszczenie.

Zaznacz obiekt, którego położenie chcesz zmienić.

Na pasku narzędzi Rozmieszczenie kliknij odpowiednią ikonę, aby wybrać żądany rodzaj
rozmieszczenia.
Zwróć uwagę na karty warstw umieszczone u dołu rysunku. Obiekty na stronach programu
Draw można umieszczać w różnych warstwach. Możliwe jest definiowanie własnych warstw i
wstawianie w nie obiektów. Każda warstwa może być ustawiona do wydruku lub wyświetlania
niezależnie od pozostałych.

▼ Edycja tekstu na rysunku
Wybierz obiekt zawierający tekst, który chcesz edytować.

Zmodyfikuj obiekt.
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Edycja rysunku
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■ Aby sformatować tekst, wybierz Format→Znak lub Format→Akapit i określ opcje
formatowania.

■ Aby zmienić tekst, dwukrotnie kliknij obiekt, zaznacz tekst i wprowadź zmiany.
■ Aby usunąć cały tekst oraz obiekt, naciśnij klawisz Delete lub BackSpace.

Edycja rysunku
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Oracle Open Office Base

Oracle Open Office Base to interfejs bazy danych w pakiecie Oracle Open Office. W aplikacji
dostępne są: edytor formularzy z 25 różnymi formantami, obsługa podformularzy, tworzenie
makr, edytor zapytań, rozbudowany edytor raportów oraz łączność za pomocą protokołów
MySQL, JDBC i Open Database Connectivity (ODBC). Aplikacja umożliwia łatwe tworzenie
niezależnych dokumentów bazy danych zawierających wszystkie odpowiednie dane, definicje
tabel, raporty oraz formularze.

Dostęp do baz danych

R O Z D Z I A Ł 8

87



Niniejszy rozdział zawiera krótki przegląd funkcji aplikacji Oracle Open Office 3 Base. Base
stanowi graficzny interfejs dostępu do baz danych. Bazy danych można tworzyć i edytować na
komputerze lokalnym lub na serwerze. Podczas pracy z bazami danych można używać okien
dialogowych pakietu Oracle Open Office 3 lub poleceń języka SQL. Dane z innych programów
pakietu Oracle Open Office 3 można przenosić za pomocą polecenia kopiuj i wklej lub poprzez
przeciąganie i upuszczanie.

Poniższa lista przedstawia niektóre obsługiwane rodzaje baz danych:

■ HSQL — macierzysty typ bazy danych w programie Base.
Używanie HSQL jako typu bazy danych umożliwia przechowywanie wszystkich rekordów w
plikach bazy danych. Oznacza to, że w pliku bazy danych przesyłanym innym
użytkownikom znajdują się wszystkie rekordy w tabelach danych, zapytania, formularze i
raporty.

■ dBASE — wszystkie pliki .dbf wewnątrz folderu są traktowane jako jedna baza danych
dBASE.

■ MySQL oraz inne serwerowe bazy danych — obsługiwane przez sterowniki macierzystych
baz danych lub dostępne za pomocą JDBC lub ODBC.

■ Systemowa książka adresowa (książka adresowa systemu Windows, książka aplikacji
Thunderbird, inne) — tylko do odczytu.

■ Arkusze programów Calc i Excel — mogą być używane jako pliki bazy danych tylko do
odczytu.

Plik bazy danych pakietu Oracle Open Office
W pliku bazy danych pakietu Oracle Open Office przechowywane są metody oraz formaty
dostępu do bazy danych. Po otwarciu pliku bazy danych wyświetlone zostanie okno podobne
do przedstawionego na ilustracji.

W pliku bazy danych pakietu Oracle Open Office przechowywane są informacje na temat
układu lub planu tabel, kwerend, formularzy oraz raportów. W przypadku plików baz danych
opartych na HSQL, plik bazy danych może zawierać również rekordy danych. Główne elementy
bazy danych to m.in.:

Tabele Pola tabel określają elementy każdego rekordu danych.

Kwerendy Kwerenda jest niestandardowym widokiem tabeli. Kwerendę definiuje się, aby
wyświetlić tylko niektóre pola tabeli.

Formularze Formularz jest maską wprowadzania i wyświetlania danych umożliwiającą
łatwiejsze zarządzanie danymi niż za pomocą tabeli czy zapytania.

Raporty Raport określa zawartość wydruku tabeli lub kwerendy.

Dostęp do baz danych
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Tworzenie pliku bazy danych pakietu Oracle Open
Office
Kreator bazy danych umożliwia dodawanie nowego pliku bazy danych oraz rejestrację bazy
danych jako źródła danych w pakiecie Oracle Open Office. Kreator tworzy plik zawierający
informacje na temat bazy danych, w tym na temat kwerend, raportów i formularzy połączonych
z bazą danych.

▼ Dodawanie nowej bazy danych jako źródła danych pakietu Oracle
Open Office

Wybierz Plik→Nowy→Baza danych.
Wyświetlony zostanie ekran Kreatora bazy danych.

Wykonaj kolejne czynności i określ opcje.

(Opcjonalne)Utwórz nową tabelę.

a. Na ostatnim ekranie Kreatora bazy danych, wybierz polecenie uruchomienia Kreatora tabeli.

b. Wprowadź dane do nowej tabeli.

Praca z bazami danych w programie Oracle Open Office 3 Base
Plik bazy danych można otworzyć za pomocą polecenia Otwórz w menu Plik.

▼ Tworzenie nowej tabeli w bazie danych
Tabela bazy danych jest zbiorem rekordów danych zorganizowanych w formie wierszy i
kolumn. Wiersz w tabeli przedstawia rekord danych. Kolumna jest to jedno pole rekordu.

Program Base umożliwia “zarejestrowanie” pliku bazy danych. Dzięki temu pliku bazy danych
można używać w innych modułach pakietu Oracle Open Office. W czasie “rejestracji” nie są
wysyłane żadne dane. Aby można było użyć pól i rekordów do operacji przeciągania i
upuszczania w widoku bazy danych (F4) lub do korespondencji seryjnej i drukowania etykiet,
pola i rekordy muszą pochodzić z zarejestrowanego pliku bazy danych.
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Praca z bazami danych w programie Oracle Open Office 3 Base
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Uwaga – Dla każdej tabeli w programie Base wymagany jest klucz podstawowy, aby możliwa była
edycja rekordów. Klucz podstawowy zawiera unikatową wartość dla każdego rekordu.

Aby otworzyć plik bazy danych, do którego ma zostać dodana nowa tabela, z menu Plik wybierz
polecenie Otwórz.

W oknie programu Oracle Open Office Base wybierz opcję Tabele.

W panelu Zadania, wybierz Użyj Kreatora, by utworzyć Tabelę.

▼ Dodawanie danych do tabeli w bazie danych
Aby otworzyć plik bazy danych zawierający tabelę, z menu Plik wybierz polecenie Otwórz.

Kliknij ikonę Tabele w lewym panelu.

Dwukrotnie kliknij nazwę tabeli, do której dodane mają zostać rekordy danych.

Wprowadzić dane.
Po zabraniu kursora z bieżącego rekordu danych, zmiany zostają zapisane automatycznie.

▼ Tworzenie raportu bazy danych za pomocą Kreatora
Raport bazy danych jest dokumentem tekstowym prezentującym dane z bazy danych w sposób
określony przez użytkownika. Program umożliwia tworzenie raportów zawierających
najbardziej aktualne dane lub dane aktualne podczas tworzenia raportu.
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Praca z bazami danych w programie Oracle Open Office 3 Base
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Aby otworzyć plik bazy danych, dla którego ma zostać utworzony raport, z menu Plik wybierz
polecenie Otwórz.

W oknie programu Oracle Open Office Base wybierz opcję Raporty.

Wybierz polecenie Użyj Kreatora, aby utworzyć Raport.

Postępuj zgodnie z instrukcjami.
Utworzyć można dwa rodzaje raportów: statyczny obraz danych aktualnych w czasie tworzenia
raportu lub dokument z aktywnymi odsyłaczami do aktualnych danych.

▼ Tworzenie raportu bazy danych w Widoku
projektowania
Użytkownik może ręcznie tworzyć własne raporty z baz danych za pomocą zainstalowanego
rozszerzenia Konstruktor raportów Oracle.
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Praca z bazami danych w programie Oracle Open Office 3 Base
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Aby otworzyć plik bazy danych, dla którego ma zostać utworzony raport, z menu Plik wybierz
polecenie Otwórz.

W oknie programu Oracle Open Office Base wybierz opcję Raporty.

Wybierz polecenie Utwórz raport w Widoku projektowania.
Wyświetlone zostanie okno Raport podstawowy. W prawym dolnym rogu ekranu przez chwilę
będzie wyświetlany Agent pomocy.

Kliknij pomoc i postępuj zgodnie z instrukcjami opcji pomocy danej aplikacji.

▼ Otwieranie raportu bazy danych
W dowolnym programie pakietu Oracle Open Office wybierz kolejno opcję Plik→Otwórz.

Znajdź plik bazy danych zawierający raport i kliknij Otwórz.

W oknie programu Oracle Open Office Base, kliknij ikonę Raporty.
Wyświetlona zostanie lista raportów dla bieżącej bazy danych.

Dwukrotnie kliknij raport, który chcesz wyświetlić.
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Praca z bazami danych w programie Oracle Open Office 3 Base
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Rozszerzenie funkcjonalności

Funkcjonalność pakietu Oracle Open Office można rozszerzyć przez pobranie i zainstalowanie
dodatków zwanych rozszerzeniami. Menedżer rozszerzeń, otwierany z menu Narzędzia,
umożliwia obsługę wszystkich pobranych rozszerzeń.

Rozszerzenia ogólne
Oprogramowanie Oracle Open Office zawiera kilka dodatkowych rozwiązań. Pliki rozszerzeń
*.oxt znajdują się w folderze rozszerzeń zestawu plików systemu Oracle E-Delivery.

Uruchomienie większości rozszerzeń powoduje dodanie ich poleceń menu do pasków menu
pakietu Oracle Open Office lub wyświetlenie ich własnych pasków narzędzi. Aby uzyskać
pomoc na temat rozszerzenia, naciśnij klawisz F1 w celu otworzenia okna pomocy, a następnie
wpisz nazwę rozszerzenia w polu wyszukiwania na karcie Indeks.

Niektóre rozszerzenia są już zainstalowane w pakiecie Office:
■ Oracle Weblog Publisher

Otwórz, edytuj i zapisuj ilustrowane blogi na serwerze Weblog.
■ Oracle Wiki Publisher

Wysyłaj dokumenty tekstowe do publikacji na serwerze MediaWiki.
■ eFax Messenger

Wysyłaj i odbieraj faksy za pomocą usługi faksowej online eFax.
■ Konsola osoby prezentującej firmy Oracle

Wyświetl podgląd slajdu i notatki prelegenta na ekranie podczas pokazu slajdów na innym
ekranie.

■ Minimalizator prezentacji Oracle
Optymalizuj rozmiar plików prezentacji.

■ Oracle PDF Import
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Importuj pliki PDF w celu dokonania niedużych zmian. Eksportuj hybrydowe pliki
ODF/PDF.

■ Konstruktor raportów Oracle
Interaktywnie projektuj raporty baz danych.

■ MySQL Connector
Bezpośrednio połącz program Base z serwerem MySQL.

■ Słowniki sprawdzania pisowni, podziału wyrazów i tezaurusa
Wybierz języki, w których ma być sprawdzana pisownia.

■ Profesjonalne szablony
Odkryj więcej opcji w oknie Szablony i dokumenty.

Integracja Oracle Open Office Enterprise
Obecne wydanie pakietu Oracle Open Office zapewnia nową i ulepszoną funkcjonalność
umożliwiającą łatwą integrację oprogramowania w środowisku Enterprise. Usprawnij
współpracę przez połączenie z systemami zarządzania treścią, np. Microsoft Sharepoint lub
Alfresco. Połącz pakiet Oracle Open Office z używanymi aplikacjami środowiska Oracle, np.
Oracle E-Business Suite i Oracle Business Intelligence.

Uwaga – Należy zwrócić uwagę, że niektóre funkcje są dostępne tylko w wersji Enterprise
Edition pakietu Oracle Open Office. Więcej informacji można znaleźć w witrynie
http://www.oracle.com/office.

Integracja z programem Oracle E-Business Suite
Integracja internetowego interfejsu ADI w pakiecie Oracle Open Office umożliwia
przeniesienie danych z programu Oracle E-Business Suite do arkusza programu Oracle Open
Office Calc oraz analizę danych E-Business za pomocą technik wprowadzania i modelowania
danych. W pakiecie Oracle Open Office for Windows integracja programu Oracle E-Business
Suite jest dostępna w konfiguracji standardowej.

Uwaga – Integracja jest dostępna tylko w systemie Windows.

Integracja z programem Oracle Business Intelligence
Rozszerzenie Oracle Open Office Connector do programu Oracle Business Intelligence
umożliwia dostęp i uruchamianie żądań programów Oracle Business Intelligence Enterprise
Edition (BI EE) i Standard Edition One (SE1) bezpośrednio w pakiecie Oracle Open Office.

Integracja Oracle Open Office Enterprise
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Dzięki odświeżalnym żądaniom użytkownik może skorzystać nie tylko z macierzystych funkcji
pakietu Oracle Open Office, ale również ze skalowalności i wydajności serwera Oracle Business
Intelligence (BI) Server. Ponieważ żądania odnoszą się do pojedynczego źródła informacji
określonego w danych serwera Oracle Business Intelligence Server, informacje są spójne dla
całej organizacji. Rozszerzenie Oracle Open Office Connector do programu Oracle Business
Intelligence umożliwia komunikację z warstwą usług Oracle BI Presentation Services za
pomocą standardowych usług internetowych i języka XML.

Więcej informacji na temat używania rozszerzenia Oracle Open Office Connector do programu
Oracle Business Intelligence można znaleźć w opcji pomocy danej aplikacji zawartej w pakiecie
Oracle Open Office. Naciśnij klawisz F1, aby otworzyć okno pomocy, i wybierz temat na karcie
Zawartość lub wyszukaj temat na karcie Indeks lub Znajdź.

Funkcje

■ Bieżące dane, które można odświeżać, przychodzące z serwera Oracle Business Intelligence
Server.

■ Wstaw tabele i tabele przestawne z programu Oracle BI do programu Oracle Open Office
Calc w postaci odświeżalnych obiektów. Tabele można odświeżać przez pobranie
najnowszych danych z serwera Oracle Business Intelligence Server.

■ Wstaw wykresy z programu Oracle BI do programów Oracle Open Office Writer, Calc,
Impress i Draw w postaci odświeżalnych obiektów. Wykresy można odświeżać przez
pobranie najnowszych danych z serwera Oracle Business Intelligence Server.
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■ Wszystkie zmiany, np. zmiana typu, kolorów i innych właściwości wykresu w pakiecie
Oracle Open Office, są zachowywane podczas odświeżania wykresu.

■ Zastosuj style z programu Oracle Open Office Calc do danych w programie Oracle BI:
formaty danych, czcionki, a nawet formaty warunkowe. Style są zachowywane podczas
odświeżania danych w programie Oracle BI.

Instalacja rozszerzenia Oracle Open Office Connector do programu Oracle Business
Intelligence

Aplikacja Oracle Open Office Connector do programu Oracle Business Intelligence znajduje się
w zestawie plików systemu E-Delivery w folderze z rozszerzeniami do pakietu Open Office.

1. W oknie pakietu Oracle Open Office wybierz pozycję Narzędzia→Menedżer rozszerzeń.
2. W oknie dialogowym menedżera rozszerzeń kliknij przycisk Dodaj, wybierz plik

rozszerzenia oracle-bi-connector.oxt, a następnie kliknij przycisk Otwórz.
3. Zamknij pakiet Oracle Open Office oraz moduł Szybkie uruchamianie, jeśli jest włączony.
4. Ponownie uruchom pakiet Oracle Open Office.

Po instalacji w pakiecie Oracle Open Office wyświetlone zostanie nowe menu Oracle BI, za
pomocą którego można połączyć się z serwerami Oracle Business Intelligence Server oraz
pracować z pochodzącymi z nich danymi.

Oracle Connector for SharePoint Server
Rozszerzenie Oracle Connector for SharePoint Server umożliwia współpracę pakietu Oracle
Open Office z serwerem Microsoft SharePoint Server oraz obsługę formatu plików ODF
(OpenDocument). Za pomocą rozszerzenia można wyszukiwać, przeglądać, edytować oraz
ewidencjonować i wyewidencjonować dokumenty przechowywane na serwerze Microsoft
Windows SharePoint Server 3.0 i Microsoft Office SharePoint Server 2007. Przed
uruchomieniem rozszerzenia Oracle Connector for SharePoint Server należy zainstalować jego
składniki na serwerze SharePoint. Oba składniki można znaleźć w pakiecie instalacyjnym.

Uwaga – Rozszerzenie jest dostępne tylko w 32-bitowych wersjach systemu Windows i serwera
SharePoint Server.

Funkcje
■ Zapewnia łatwy i szybki dostęp do dokumentów przechowywanych na serwerze Sharepoint

Server.
■ Integracja z menu pakietu Oracle Open Office.
■ Umożliwia zarządzanie istniejącymi dokumentami oraz tworzenie nowych na serwerze

Sharepoint Server.
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Instalacja składników rozszerzenia Oracle Connector for SharePoint Server

Pliki instalacyjne składników rozszerzenia Oracle Connector for SharePoint Server znajdują się
w zestawie plików systemu E-Delivery. Postępuj zgodnie z instrukcjami znajdującymi się w
załączonym podręczniku instalacji.

Instalacja rozszerzenia Oracle Connector for SharePoint

Rozszerzenie Oracle Connector for SharePoint można znaleźć w zestawie plików systemu
E-Delivery.

1. W oknie pakietu Oracle Open Office wybierz pozycję Narzędzia→Menedżer rozszerzeń.
2. W oknie dialogowym menedżera rozszerzeń kliknij przycisk Dodaj, wybierz plik

rozszerzenia oracle-connector-sharepoint.oxt, a następnie kliknij przycisk Otwórz.
3. Zamknij pakiet Oracle Open Office oraz moduł Szybkie uruchamianie, jeśli jest włączony.
4. Ponownie uruchom pakiet Oracle Open Office.

Oracle Connector for Alfresco CMS
Rozszerzenie Oracle Connector for Alfresco CMS umożliwia kompletną integrację pakietu
Oracle Open Office z serwerem Alfresco Content Management Server (CMS). Użytkownicy
mają pełny dostęp do wszystkich dokumentów przechowywanych na serwerze Alfresco. Prosty
w obsłudze interfejs ułatwia tworzenie, odczytywanie, edytowanie i zapisywanie dokumentów
oraz ich ewidencjonowanie i wyewidencjonowanie.

Funkcje

■ Zapewnia łatwy i szybki dostęp do dokumentów przechowywanych na serwerze Alfresco
CMS.

■ Integracja z menu pakietu Oracle Open Office.
■ Umożliwia kontrolę przepływów pracy z systemu zarządzania treścią bezpośrednio w

pakiecie Oracle Open Office.

Rozszerzenie Oracle Connector for Alfresco CMS można znaleźć w zestawie plików systemu
E-Delivery.

1. W oknie pakietu Oracle Open Office wybierz pozycję Narzędzia→Menedżer rozszerzeń.
2. W oknie dialogowym menedżera rozszerzeń kliknij przycisk Dodaj, wybierz plik

rozszerzenia oracle-connector-sharepoint.oxt, a następnie kliknij przycisk Otwórz.
3. Zamknij pakiet Oracle Open Office oraz moduł Szybkie uruchamianie, jeśli jest włączony.
4. Ponownie uruchom pakiet Oracle Open Office.
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Przejście z pakietu Microsoft Office

Użytkownicy, którzy poznali programy pakietu Microsoft Office (do wersji 2003), nie powinni
mieć żadnych problemów w obsłudze aplikacji pakietu Oracle Open Office. Większość funkcji
jest dostępna w tych samych miejscach, gdyż zostały rozmieszczone zgodnie ze standardowymi
regułami interfejsu systemu Windows. Jednakże niektóre aspekty pracy w pakiecie Oracle Open
Office są inne niż w pakiecie Microsoft Office.

Wymiana dokumentów z użytkownikami pakietu Microsoft
Office

Znaczna liczba użytkowników pakietu Microsoft Office może spowodować potrzebę wymiany
dokumentów z osobą, która nie ma dostępu do pakietu Oracle Open Office lub jego wersji
społecznościowej OpenOffice.org. Oznacza to, że użytkownik otrzyma dokument w formacie
Microsoft Office lub będzie musiał taki dokument przekazać innej osobie. W większości
przypadków pakiet Oracle Open Office umożliwia bezproblemową wymianę dokumentów.

Otwieranie dokumentów Microsoft Office w pakiecie
Oracle Open Office
Dokumenty Microsoft Office można otwierać w pakiecie Oracle Open Office tak samo, jak
dokumenty macierzyste tego pakietu. Standardowa konfiguracja pakietu Oracle Open Office
pozwala na otwieranie różnych formatów Microsoft Office, w tym nowych formatów docx, xlsx
i pptx wprowadzonych w wersji Microsoft Office 2007.
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Zapisywanie dokumentu Oracle Open Office w
formacie Microsoft Office
Dokumenty można również zapisywać w formacie Microsoft Office. Należy jednak zwrócić
uwagę, że nie wszystkie formaty Microsoft Office są dostępne. Z drugiej strony wszystkie
dostępne formaty można otworzyć w pakiecie Microsoft Office. Aby zapisać dokument w
innym formacie, wybierz polecenie Plik→Zapisz jako i wskaż format w polu Zapisz jako typ.

Uwaga – Dostępność formatu zależy od używanej aplikacji. Podczas zapisywania dokumentu w
postaci innego typu pliku może zostać wyświetlone okno dialogowe z informacją, że niektóre
elementy formatowania lub treści nie mogą być zapisane w nowym formacie. Aby kontynuować
zapisywanie dokumentu w nowym formacie, kliknij przycisk Zachowaj bieżący format.

Jeśli odbiorca dokumentu nie będzie go edytować, dokument można przekazać w formacie PDF
zamiast Microsoft Office. PDF to uznany format do wymiany dokumentów. Standardowa
konfiguracja pakietu Oracle Open Office umożliwia eksport do tego formatu (patrz “Praca z
dokumentami PDF” na stronie 33).

Konwersja szablonu Microsoft Office
Jeśli użytkownik korzysta z szablonów utworzonych w pakiecie Microsoft Office, może
zdecydować się na ich konwersję na format Oracle Open Office. Skonwertowane szablony będą
dostępne podczas tworzenia nowych dokumentów Oracle Open Office. Najłatwiejszym
sposobem konwersji jest otwarcie szablonu Microsoft Office w pakiecie Oracle Open Office.
Spowoduje to utworzenie nowego dokumentu Oracle Open Office na podstawie szablonu
Microsoft Office. Następnie dokument Oracle Open Office należy zapisać jako szablon za
pomocą polecenia Plik→Szablony→Zapisz. Zapisany szablon (włącznie z zawartymi w nim
stylami niestandardowymi) będzie dostępny podczas tworzenia nowych dokumentów w
pakiecie Oracle Open Office.

Korzystanie z makr Microsoft Office
Makr Microsoft Office nie można bezpośrednio uruchamiać w pakiecie Oracle Open Office z
powodu fundamentalnych różnic w językach programowania stanowiących podstawę tych
dwóch produktów. Niektóre makra programu Microsoft Excel mogą być uruchamiane w
pakiecie Oracle Open Office. Podczas otwierania dokumentu Microsoft Office zawierającego
makro w pakiecie Oracle Open Office kod tego makra jest wczytywany, ale zostaje domyślnie
dezaktywowany.
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Do pracy z dokumentami programu Excel kod makra można uaktywnić, aby umożliwić jego
wykonanie:

1. Wybierz pozycję Narzędzia→Opcje→Ładuj/Zapisz→Właściwości VBA. (W systemie Mac
OS X otwórz menu Preferencje).

2. Zaznacz pole wyboru Kod wykonywalny.

Podczas otwierania dokumentu programu Excel zawierającego makro kod makra będzie już
uaktywniony. Jeśli nie masz pewności, jakie jest działanie makra w dokumencie Excel, przed
otwarciem dokumentu w pakiecie Oracle Open Office usuń zaznaczenie pola wyboru Kod
wykonywalny. Umożliwia to sprawdzenie kodu przed jego uruchomieniem.

Nie wszystkie elementy kodu makra programu Excel można uruchomić w programie Oracle
Open Office Calc. Może być konieczne ręczne wprowadzenie zmian. W programie Calc kliknij
pozycję Narzędzia→Makra→Zarządzaj makrami→Oracle Open Office Basic, wybierz makro
do zmiany i kliknij przycisk Edytuj.

Uwaga – Jeśli użytkownik nie pracował wcześniej z kodem makra, powinien dokładnie rozważyć
wszystkie wprowadzane zmiany. Jeśli rezultat zmiany nie jest pewny, nie należy jej
wprowadzać! Może być konieczne przekazanie makr do działu IT w celu ich dalszego
opracowania.

Otwieranie dokumentów Oracle Open Office w
pakiecie Microsoft Office
Dokumenty Oracle Open Office nie są domyślnie otwierane w pakiecie Microsoft Office 2003.
Dostępny jest jednak dodatek umożliwiający użytkownikom pakietu Microsoft Office pracę z
dokumentami Oracle Open Office. Dodatek o nazwie ODF Plug-in for Microsoft Office jest
dostępny w sklepie firmy Oracle.

Uwaga – Dokumenty Oracle Open Office można otwierać w pakiecie Microsoft Office 2007 w
wersji Service Pack 2 i nowszych, ale zainstalowanie dodatku opisanego powyżej zapewnia ich
lepszą obsługę.

Kreator konwersji dokumentów
Jeśli trzeba dokonać konwersji dużej liczby dokumentów Microsoft Office, można
skonwertować wszystkie dokumenty zawarte w danym folderze na format OpenDocument
Format (ODF) używany w pakiecie Oracle Open Office. Kreator prowadzi użytkownika przez
proces kopiowania i konwertowania wszystkich dokumentów z formatów Microsoft Word,
Microsoft Excel lub Microsoft PowerPoint do formatu OpenDocument.
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1. Aby uruchomić kreator, wybierz pozycję Plik→Kreatory→Konwerter dokumentów.
2. Wybierz pozycję Microsoft Office, aby skonwertować pliki z formatów pakietu Microsoft

Office.
3. Dla każdego typu szablonu i dokumentu użytkownik określa katalog źródłowy i docelowy.

Po konwersji wszystkie dokumenty powinny zostać przejrzane, aby zweryfikować dokładność
konwersji.

Różnice między pakietami Microsoft Office i Oracle Open
Office

W tym rozdziale opisano najważniejsze różnice w działaniu i używaniu aplikacji pakietów
Microsoft Office i Oracle Open Office. Aby szybko rozpocząć pracę z nowym pakietem, osoby
korzystające z niego w pracy zawodowej powinni wziąć udział w kursie szkoleniowym Oracle
Open Office for Microsoft Office Users dostępnym w witrynie Oracle University pod adresem
http://education.oracle.com.

Krótki przegląd odpowiadających sobie poleceń można znaleźć w rozdziale “Funkcje pakietów
Microsoft Office i Oracle Open Office” na stronie 104

Programy Writer i Word
Poniżej znajduje się podsumowanie wybranych głównych różnic w działaniu programów
Writer i Word:

■ Narzędzia językowe: Ustawianie języka różni się nieznacznie w programach Writer i Word.
Występują niewielkie różnice w działaniu modułu sprawdzania pisowni i tezaurusa.
Funkcja Autouzupełnianie w programie Word nazwana jest Uzupełnianie wyrazów w
programie Writer. Tworzenie autotekstu jest odmienne w obu aplikacjach.

■ Zaznaczanie, kopiowanie i wklejanie tekstu: Sposoby zaznaczania tekstu w programach
Writer i Word nieznacznie się różnią. Narzędzie wklejania specjalnego ma inny klawisz
skrótu i działa odrobinę inaczej.

■ Wypunktowanie i numeracja: W programie Writer znajduje się kontekstowy pasek narzędzi
umożliwiający zmianę zachowania wypunktowania i numeracji. Dostosowywanie list
punktowanych i numerowanych różni się w obu aplikacjach.

■ Sekcje: Sekcje w programach Writer i Word bardzo się różnią pod względem ich tworzenia i
używania.

■ Style: W programie Writer dostępnych jest więcej typów stylów. Tworzenie i
modyfikowanie stylów różni się w obu aplikacjach. W programie Writer dostępne są
dodatkowe klawisze skrótów do stosowania stylów.
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■ Tabele: Tworzenie i modyfikowanie tabel jest odmienne w programach Writer i Word.
Przenoszenie danych w tabeli różni się nieznacznie w programie Writer.

■ Obrazy: Program Writer zawiera galerię obrazów do przechowywania i organizowania
często używanych obrazów. Sposób umieszczania obrazu na stronie jest odmienny w obu
aplikacjach. Pasek narzędzi Obraz jest odmienny w programach Writer i Word.

■ Nawigacja po dokumencie: Program Writer zawiera narzędzie Nawigator umożliwiające
przechodzenie między częściami dokumentu i ich organizację. Program Word zawiera
różne narzędzia pełniące te same funkcje, np. Plan dokumentu, Widok konspektu oraz
Przejdź do.

■ Orientacja strony, nagłówki i stopki: Dodanie strony o orientacji poziomej do dokumentu o
orientacji pionowej jest odmienne w obu aplikacjach. Wstawianie nagłówków i stopek różni
się w programie Writer. Numerowanie stron działa inaczej.

Programy Calc i Excel
■ Nawigacja po arkuszu: Program Calc zawiera narzędzie Nawigator umożliwiające

przechodzenie między częściami arkusza. Program Excel zawiera różne narzędzia pełniące
te same funkcje, np. Przejdź do oraz Nazwy zakresów.

■ Wprowadzanie i usuwanie danych: Narzędzie Wypełnienie w programie Calc działa
podobnie (z niewielkimi różnicami) do narzędzia Autowypełnianie w programie Excel.
Działanie klawiszy Delete i Backspace jest odmienne w obu aplikacjach.

■ Wklejanie danych: Narzędzie wklejania specjalnego ma inny klawisz skrótu i działa
odrobinę inaczej.

■ Style: W programie Calc dostępnych jest więcej typów stylów. Tworzenie i modyfikowanie
stylów różni się bardzo w obu aplikacjach.

■ Formatowanie warunkowe: Stosowanie formatowania warunkowego do komórek jest
odrobinę inne w programie Calc.

■ Filtrowanie danych: Tworzenie filtrów różni się nieznacznie w programach Calc i Excel.
Filtry niestandardowe w programie Excel nazywane są Filtrami standardowymi w
programie Calc.

■ Tworzenie formuł: Do rozdzielenia argumentów formuły w programie Calc używane są
średniki, a nie przecinki jak w programie Excel. Pasek formuły jest nieznacznie inny w
programie Calc. Działanie kreatora funkcji jest odmienne w obu aplikacjach. Tworzenie
funkcji zagnieżdżonych za pomocą kreatora funkcji jest łatwiejsze w programie Calc. Lista
funkcji jest nieznacznie inna w programie Calc. Klawisz skrótu do tworzenia bezwzględnego
odwołania do komórki jest różny w programach Calc i Excel. Do sprawdzania, czy w
formułach nie występują błędy, w programie Calc służy narzędzie Detektyw, a w programie
Excel narzędzie Inspekcja formuł.

■ Wykresy: Kreator wykresów jest odrobinę inny w programach Calc i Excel.
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■ Ochrona: Ochrona arkuszy i komórek przed wprowadzeniem przypadkowych zmian jest
nieznacznie odmienna w obu aplikacjach.

■ Interaktywne tabele danych: Nazywane są tabelami Pilota danych w programie Calc, a
tabelami przestawnymi w programie Excel. Sposób tworzenia i używania tabel jest
odmienny w obu aplikacjach.

■ Szablony: Tworzenie szablonów dokumentów programu Calc jest inne niż w programie
Excel.

■ Rewizja dokumentów: Sposób śledzenia zmian jest odmienny w programie Calc i w
programie Excel.

Programy Impress i PowerPoint
■ Układ okna: Programy Impress i PowerPoint zawierają podobne narzędzia i widoki, lecz

sposób ich wyświetlania w obszarze roboczym jest nieznacznie inny. W programie Impress
również występują panele zadań i podokna, ale są one umieszczone w innych miejscach na
ekranie. U góry głównego obszaru roboczego programu Impress znajdują się karty służące
do przełączania się między różnymi widokami.

■ Praca ze slajdami: Chociaż ogólny proces dodawania, zmiany nazwy i przenoszenia slajdów
jest taki sam w programach Impress i PowerPoint, menu i klawisze skrótów są jednak
odrobinę inne. Sposoby dodawania treści do slajdów oraz zmiany ich układu są podobne,
jednak ponownie występują w nich nieznaczne różnice.

■ Style: W programie Impress dostępnych jest więcej typów stylów. Tworzenie i
modyfikowanie stylów różni się w obu aplikacjach.

■ Wzorce slajdów: Korzystanie z wzorców slajdów jest nieznacznie odmienne w programie
Impress.

■ Pokazy slajdów: Konfigurowanie i uruchamianie pokazu slajdów jest podobne w obu
aplikacjach, występują jednak niewielkie różnice w położeniu menu i opcji.

■ Szablony: Tworzenie szablonów dokumentów programu Impress jest inne niż w programie
PowerPoint.

Funkcje pakietów Microsoft Office i Oracle Open Office
W poniższych tabelach pokazano jakie funkcje pakietu Oracle Open Office odpowiadają
głównym funkcjom pakietu Microsoft Office. Nazwy funkcji mogą być odmienne w obu
pakietach. Poniższe porównanie uwzględnia funkcje pakietu Microsoft Office 2003. Nowsze
wersje mogą zawierać inne funkcje.
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TABELA 10–1 Ogólne działanie

Microsoft Office Oracle Open Office

Clipart

Wstaw→Obraz→Clipart

Galeria

Narzędzia→Galeria

Wstaw obraz

Wstaw→Obraz

Wstaw obraz

Wstaw→Obraz lub

Użyj Galerii do wstawiania obrazów i zarządzania
nimi.

Tworzenie szablonu z dokumentu

Plik→Zapisz jako→

Wybierz szablon w polu Zapisz jako typ

Tworzenie szablonu z dokumentu

Plik→Zapisz jako→

Wybierz szablon w polu Zapisz jako typ lub

Plik→Szablony→Zapisz

Umożliwia dodanie szablonu bezpośrednio do
kolekcji szablonów.

Określanie ustawień

Narzędzia→Opcje

(Operację należy wykonać oddzielnie we wszystkich
aplikacjach).

Określanie ustawień

Narzędzia→Opcje

(Operację można wykonać w dowolnej aplikacji).

Zamykanie wszystkich wystąpień aplikacji, np. Word

Plik→Zakończ

Zamykanie aplikacji pakietu Oracle Open Office

Plik→Zakończ

Wklej specjalnie

Edycja→Wklej specjalnie

Wklej specjalnie

Edycja→Wklej specjalnie lub Ctrl+Shift+V

TABELA 10–2 Edycja tekstu

Microsoft Office Word Oracle Open Office Writer

Śledzenie zmian

Narzędzia→Śledź zmiany

Rejestrowanie zmian

Edycja→Zmiany→Rejestruj

Tezaurus

Narzędzia→Język→Tezaurus lub Shift+F7 lub

Kliknięcie prawym przyciskiem myszy → Synonimy

Tezaurus

Narzędzia→Język→Tezaurus lub Ctrl+F7
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TABELA 10–2 Edycja tekstu (Ciąg dalszy)
Microsoft Office Word Oracle Open Office Writer

Tworzenie lub modyfikowanie stylu

Format→Style i formatowanie

Kliknięcie prawym przyciskiem myszy nazwy stylu i
wybranie polecenia Modyfikuj lub

Kliknięcie przycisku Nowy styl

Tworzenie lub modyfikowanie stylu

Format→Style i formatowanie lub F11

Kliknięcie prawym przyciskiem myszy nazwy stylu i
wybranie polecenia Modyfikuj lub

Kliknięcie prawym przyciskiem myszy w oknie stylów
i wybranie polecenia Nowy

Czyszczenie formatowania

Edycja→Wyczyść→Formaty

Wyczyść formatowanie akapitów: Ctrl+Q

Wyczyść formatowanie znaków: Ctrl+Space

Czyszczenie formatowania

Wybierz polecenie Wyczyść formatowanie z listy
rozwijanej stylów na pasku narzędzi Formatowanie

Domyślne formatowanie stylu

Format→Formatowanie domyślne lub Ctrl+M

Wyświetlanie lub ukrywanie błędów ortograficznych

Narzędzia→Opcje→Pisownia i gramatyka→Ukryj
błędy ortograficzne w tym dokumencie lub

Kliknięcie prawym przyciskiem myszy ikony na pasku
stanu

Automatyczne sprawdzanie pisowni

Kliknięcie ikony na standardowym pasku narzędzi

Autouzupełnianie

Narzędzia→Opcje Autokorekty→Autotekst

Uzupełnianie wyrazów

Narzędzia→Opcje autokorekty→Uzupełnianie
wyrazów

Zacznij numerację od nowa

Format→Punktory i numeracja→Rozpocznij
numerację od nowa lub

Kliknięcie prawym przyciskiem myszy na liście →
Rozpocznij numerację od nowa

Zacznij numerację od nowa

Kliknięcie ikony na pasku narzędzi Wypunktowanie i
numeracja lub

Kliknięcie prawym przyciskiem myszy na liście →
Zacznij numerację od nowa

Dodawanie sekcji do dokumentu

Wstaw→Podział→wybór Typu podziału sekcji

Dodawanie sekcji do dokumentu

Wstaw→Sekcja

(Uwaga: Sekcje w programie Writer różnią się
znacznie od sekcji w programie Word).

Korespondencja seryjna

Narzędzia→Listy i dokumenty
wysyłkowe→Korespondencja seryjna

Tworzenie listu seryjnego z użyciem źródła danych

Narzędzia→Kreator korespondencji seryjnej (Proces
jest inny niż w programie Word).

Przytnij obraz

Opcja na pasku narzędzi Obraz

Przytnij obraz

Format→Obraz→Przytnij

Funkcje pakietów Microsoft Office i Oracle Open Office

Podręcznik dla początkujących użytkowników pakietu Oracle Open Office 3 • Wrzesień 2010106



TABELA 10–2 Edycja tekstu (Ciąg dalszy)
Microsoft Office Word Oracle Open Office Writer

Kompresuj obrazy

Opcja na pasku narzędzi Obraz

Brak odpowiednika w programie Writer

Plan dokumentu

Widok→Plan dokumentu

Nawigator

Widok→Nawigator lub F5

Rozwinięcie pozycji Nagłówki

Przejdź do

Edycja→Przejdź do lub Ctrl+G

Nawigator

Widok→Nawigator lub F5

Użycie pola z numerem strony u góry okna Nawigator
lub

Rozwinięcie wybranej pozycji, np. Sekcje, Notatki

Widok konspektu

Widok→Konspekt

Nawigator

Widok→Nawigator lub F5

Rozwinięcie pozycji Nagłówki, kliknięcie ikony
Widok zawartości i przeciągnięcie wybranych
nagłówków

Nagłówki i stopki

Widok→Nagłówek i stopka

Nagłówki i stopki

Wstaw→Nagłówek → [Styl strony] lub

Wstaw→Stopka → [Styl strony]

(Proces jest inny niż w programie Word)

TABELA 10–3 Arkusze kalkulacyjne

Microsoft Office Excel Oracle Open Office Calc

Śledzenie zmian

Narzędzia→Śledź zmiany→Wyróżnij zmiany

Rejestrowanie zmian

Edycja→Zmiany→Rejestruj

Tezaurus jest niedostępny. Tezaurus

Narzędzia→Język→Tezaurus lub Ctrl+F7
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TABELA 10–3 Arkusze kalkulacyjne (Ciąg dalszy)
Microsoft Office Excel Oracle Open Office Calc

Tworzenie lub modyfikowanie stylu

Format→Styl

Wybór nazwy stylu i kliknięcie przycisku Modyfikuj
lub

Wpisanie nowej nazwy stylu i kliknięcie przycisku
Dodaj

Tworzenie lub modyfikowanie stylu

Format→Style i formatowanie lub F11

Kliknięcie prawym przyciskiem myszy nazwy stylu i
wybranie polecenia Modyfikuj lub

Kliknięcie prawym przyciskiem myszy w oknie stylów
i wybranie polecenia Nowy

Czyszczenie formatowania

Edycja→Wyczyść→Formaty

Czyszczenie formatowania

Ustawienie stylu domyślnego w oknie stylów lub
użycie klawisza Delete

Domyślne formatowanie stylu

Format→Formatowanie domyślne lub Ctrl+M

Brak sprawdzania pisowni w trakcie pisania Automatyczne sprawdzanie pisowni

Kliknięcie ikony na standardowym pasku narzędzi

Autosumowanie

Kliknięcie przycisku Autosumowanie na
standardowym pasku narzędzi

Autosumowanie

Kliknięcie przycisku Autosumowanie na pasku
formuły

Znajdowanie nazw zakresów

W polu rozwijanym Nazwy zakresów

Znajdowanie nazw zakresów

W polu rozwijanym Nazwy zakresów lub

Nawigator (F5)

Autowypełnianie

Kopiowanie: kliknięcie i przeciągnięcie prawego
dolnego rogu komórki

Wypełnianie serią: kliknięcie i przeciągnięcie prawego
dolnego rogu komórki, a następnie kliknięcie tagu
inteligentnego w celu wybrania opcji wypełnienia

Narzędzie Autowypełnianie

Wypełnianie serią: kliknięcie i przeciągnięcie prawego
dolnego rogu komórki (domyślna opcja po wykryciu
serii)

Kopiowanie: Ctrl oraz kliknięcie i przeciągnięcie
prawego dolnego rogu komórki

Autofiltr i Filtr niestandardowy

Autofiltr: Dane→Filtr→Autofiltr

Filtr niestandardowy: wybór z listy rozwijanej
Autofiltr

Autofiltr i Filtr standardowy

Autofiltr: Dane→Filtr→Autofiltr

Filtr standardowy: Dane→Filtr→Filtr standardowy
(Filtr standardowy można zastosować bez
wcześniejszego zastosowania autofiltru).

Bezwzględne odwołanie do komórki

F4

Bezwzględne odwołanie do komórki

Shift+F4
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TABELA 10–3 Arkusze kalkulacyjne (Ciąg dalszy)
Microsoft Office Excel Oracle Open Office Calc

Inspekcja formuł

Narzędzia→Inspekcja formuł

Detektyw

Narzędzia→Detektyw

Tabela przestawna

Dane→Tabela przestawna oraz Raport wykresu
przestawnego

Pilot danych

Dane→Pilot danych→Rozpocznij

TABELA 10–4 Prezentacje

Microsoft Office PowerPoint Oracle Open Office Impress

Tezaurus

Narzędzia→Tezaurus lub Shift+F7

lub Kliknięcie prawym przyciskiem myszy →
Synonimy

Tezaurus

Narzędzia→Język→Tezaurus lub Ctrl+F7

Czyszczenie formatowania jest niedostępne. Domyślne formatowanie stylu

Format→Formatowanie domyślne lub Ctrl+M

Wyświetlanie lub ukrywanie błędów ortograficznych

Narzędzia→Opcje→Pisownia i gramatyka→Ukryj
błędy ortograficzne w tym dokumencie

Automatyczne sprawdzanie pisowni

Kliknięcie ikony na standardowym pasku narzędzi

Okienko slajdów (główny obszar roboczy) Karta Normalny w obszarze roboczym

Karta Konspekt (po lewej stronie głównego obszaru
roboczego)

Karta Konspekt w obszarze roboczym

Okienko notatek (pod głównym obszarem roboczym) Karta Notatki w obszarze roboczym

Wyświetlanie materiałów informacyjnych

Plik→Podgląd wydruku

Karta Widok materiałów informacyjnych w obszarze
roboczym

Sortowanie slajdów

Widok→Sortowanie slajdów

Karta Sortowanie slajdów w obszarze roboczym

Karta Slajdy (po lewej stronie głównego obszaru
roboczego)

Panel Slajdy (po lewej stronie obszaru roboczego)

Zmiana widoku w panelu Zadania

Kliknięcie listy rozwijanej u góry panelu Zadania

Zmiana widoku w panelu Zadania

Kliknięcie paska tytułowego panelu Zadania

Wstaw nowy slajd

Wstaw→Nowy slajd lub Ctrl+M

Wstaw slajd

Wstaw→Slajd (brak klawisza skrótu)

Funkcje pakietów Microsoft Office i Oracle Open Office

Rozdział 10 • Przejście z pakietu Microsoft Office 109



Funkcje pakietów Microsoft Office i Oracle Open Office

Podręcznik dla początkujących użytkowników pakietu Oracle Open Office 3 • Wrzesień 2010110



Dodatek

Niniejszy dodatek zawiera listy najczęściej używanych skrótów klawiaturowych dla programów
pakietu Oracle Open Office. Otwórz opcję pomocy danej aplikacji, aby odnaleźć kompletne
listy dostępnych skrótów klawiaturowych oraz skrótów klawiaturowych, jakich należy używać
w przypadku, gdy korzystanie z myszy jest niemożliwe.

Uwaga – System może używać odwzorowania klawiatury, rezerwując niektóre kombinacje
klawiszy dla czynności systemowych. W pakiecie Oracle Open Office 3 nie można używać tych
kombinacji klawiszy w celu wprowadzania poleceń za pomocą klawiatury. W większości
przypadków można przypisać inne kombinacje klawiszy do operacji systemowych i operacji w
pakiecie Oracle Open Office 3.

TABELA A–1 Skróty klawiaturowe dla wszystkich aplikacji

Czynność Skrót klawiaturowy

Otwiera dokument Control+O

Zapisuje bieżący dokument Control+S

Tworzy nowy dokument Control+N

Wyświetla okno dialogowe Szablony i dokumenty Shift+Ctrl+N

Drukuje bieżący dokument Control+P

Zamyka oprogramowanie Oracle Open Office 3 Control+Q

Wycina zaznaczony tekst lub obiekty do schowka Control+X

Kopiuje zaznaczony tekst lub obiekty do schowka Control+C

Wkleja zawartość do schowka Control+V

Zaznacz wszystko Control+A

AD O D A T E K A

111



TABELA A–1 Skróty klawiaturowe dla wszystkich aplikacji (Ciąg dalszy)
Czynność Skrót klawiaturowy

Cofa ostatnią czynność Control+Z

Wyświetla okno dialogowe Znajdź i zamień Control+F

Kontynuuje wyszukiwanie ostatniego wyszukiwanego
terminu

Shift+Ctrl+F

TABELA A–2 Skróty klawiaturowe dla aplikacji Writer

Czynność Skrót klawiaturowy

Przełącza widok paska narzędzi Formuła F2

Wstawia Autotekst F3

Przełącza widok źródła danych F4

Przełącza widok okna narzędzia Nawigator F5

Przechodzi do określonego numeru strony Shift+Ctrl+F5

Wyświetla okno dialogowe Sprawdzania pisowni F7

Przełącza widok okna narzędzia Style i formatowanie F11

TABELA A–3 Znaki klawiatury w aplikacji Writer

Czynność przypisana do znaku Skrót klawiaturowy

Wstawia niestandardowe łączniki Control+-(klawisz minus)

Wstawia myślnik (nie łącznik) Shift+Ctrl+-(klawisz minus)

Wstawia spację twardą Shift+Ctrl+klawisz spacji

Wstawia przejście do nowego wiersza w tym samym
akapicie

Shift+Enter

Wstawia ręczny podział strony Control+Enter

Wstawia podział kolumny w tekście podzielonym na
kolumny

Shift+Ctrl+Enter

Dodatek
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Słownik

Niniejszy Glosariusz przedstawia wyjaśnienia głównych terminów stosowanych w niniejszym
Przewodniku.

Aplikacje Różne programy współdzielące wspólny interfejs użytkownika. Główne aplikacje służące do edycji
dokumentów to Writer, Calc, Impress oraz Draw.

Galeria Okno, w którym można zarządzać obrazami oraz dźwiękami, które mają być użyte w dokumencie.
Obiekty galerii są wstępnie posortowane w folderach tematycznych zwanych kompozycjami. Użytkownik
może tworzyć własne kompozycje oraz dodawać obiekty do istniejących kompozycji.

Makro W kontekście pakietu Oracle Open Office, makro oznacza kolejność czynności zapisanych w języku
programowania, np. Oracle Open Office Basic lub JavaScript. Użytkownik może dodawać makra do
pakietu Oracle Open Office za pomocą rejestratora makr lub przez napisanie własnego kodu programu.
Opcja pomocy danej aplikacji zawiera więcej informacji na temat tworzenia własnych okien dialogowych,
przypisywania makr do zdarzeń lub klawiszy itp.

Menu kontekstowe Menu kontekstowe otwiera się po kliknięciu prawym przyciskiem na dokumencie. Menu kontekstowe
wyświetla zbiór poleceń menu

Pasek narzędzi Niewielkie okno zawierające ikony służące do wykonywania popularnych czynności np. wstawiania
wykresów. Paski narzędzi można umieszczać w dowolnym miejscu na ekranie oprogramowania Oracle
Open Office.

Przeciągnij i upuść Używanie myszy do kopiowania i przenoszenia wybranych tekstów i obiektów do innych miejsc poprzez
zaznaczenie tekstu lub obiektu, przytrzymanie przycisku myszy oraz przeniesienie w inne miejsce.

Zakotwiczanie
okien

Takie okna jak np. Nawigator lub Style i formatowanie, można zakotwiczyć na krawędzi okna dokumentu,
aby pozostawały widoczne nie zasłaniając dokumentu.
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Indeks

Numery i symbole
śledzenie zmian, 49–50
— rozszerzenia do zarządzania treścią, 94–97

A
aplikacja do obsługi baz danych Base, 87–92
aplikacja do rysowania Draw, 81–86
arkusze kalkulacyjne, 55–72

edytowanie, 60
funkcje, 65
wykresy, 69–72
wzory, 63–66

arkusze kalkulacyjne Calc, 55–72
automatyczne uzupełnianie komórek, 59–60
automatyczne zastępowanie wyrazów, 41–50

B
bazy danych, 87–92

raporty, 90
tabele, 89–90

BI Business Intelligence, 94–97

C
Centrum startowe, 23–24

D
Dokumenty PDF, 33–34
dokumenty tekstowe

edytowanie, 41–50
formatowanie, 47–49
tabele, 51–52
tworzenie nowego, 39–41

E
edycja, prezentacje, 75–79
Edytor tekstu Writer, 39–54
edytowanie

arkusze kalkulacyjne, 60
dokumenty tekstowe, 41–50
rysunki, 84–86

efekty slajdów, 78–79

F
formatowanie

arkuszy kalkulacyjnych, 61–63
dokumenty tekstowe, 47–49

funkcje w arkuszach kalkulacyjnych, 65

G
Galeria, 30
Galeria obrazów, 30–31
grafika, 30
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grafika (Ciąg dalszy)
w dokumentach tekstowych, 53–54

grafiki i bitmapy, 81–86

I
informacje dodatkowe, 10
instalacja, informacje podstawowe, 15–21
instalacja Oracle Open Office, 15–21
instalowanie

w systemie Linux lub Solaris, 18–20
w systemie Mac, 17–18
w systemie Windows, 15–17

K
Konstruktor raportów, 91–92
Kreator powitalny, 23–24
kształty, rysowanie, 82–83

M
makra, 37–38
Microsoft Office, migracja z, 99
migracja, z Microsoft Office, 99

O
obrazy, 30

w dokumentach tekstowych, 53–54
odinstalowanie

z systemu Linux lub Solaris, 20
z systemu Windows, 17

okno dialogowe wyszukiwania i zamiany, 43–44
operatory w arkuszach kalkulacyjnych, 63–64
Oracle Business Intelligence, 94–97
Oracle Open Office Base, 87–92
Oracle Open Office Calc, 55–72
Oracle Open Office Chart, 69–72
Oracle Open Office Draw, 81–86
Oracle Open Office Impress, 73–80

Oracle Open Office Math, 37
Oracle Open Office Writer, 39–54

P
paski narzędzi, 26–27
personalizacja programów pakietu Oracle Open

Office, 28
Pilot danych, 67
pokazy slajdów programu Impress, 73–80
Pokazy slajdów w programie, 79–80
pomoc, pomoc do aplikacji, 34–36
poruszanie się wewnątrz dokumentów, 50–51
prezentacje, 73–80
programowanie, 37–38
przejścia slajdów, 78
publikowanie dokumentów tekstowych, 54

R
raporty, bazy danych, 90
rejestrowanie zmian, 49–50
rozszerzenia, lista, 93–94
rozwiązywanie problemów dotyczących sprawdzania

pisowni, 46–47
rysowanie trójwymiarowych kształtów, 83
rysunki, edytowanie, 84–86

S
scenariusze, 67
skróty klawiaturowe, 111
slajdy, 73–80
Solver, 68
sprawdzanie pisowni, 44–47
style arkuszy kalkulacyjnych, 62–63
style tekstu, 48–49
szablony, 28–29
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T
tabele

w arkuszach kalkulacyjnych, 55–72
w bazach danych, 89–90
w dokumentach tekstowych, 51–52

Tekst graficzny Fontwork, 77–78
tworzenie łączy i osadzanie, 30

U
uzupełnianie wyrazów, 41–50

W
Weblog Publisher, 54
Wiki Publisher, 54
wsparcie, 34–36
wykresy, 69–72
wzory

arkusze kalkulacyjne, 63–66
Oracle Open Office Math, 37

wzory matematyczne, 37

Indeks
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